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கற்றல் ந�ோக்கங்கள்

	 இந்த பாடத்தை கற்றப்பின் மாணவர்கள் 

அறிந்து க�ொள்பவை

•	 ஓபன் ஆஃபீஸ் கால்கின் சிறப்பியல்புகளை 

அறிந்து க�ொள்ளுதல் 

•	 பல்வேறு செயற்குறிகளின் பயன்பாடுகள் 

•	 வரிசைகளை உருவாக்குதல் 

•	 அட்டவணைத்தாளில் வாய்ப்பாடுகளை 

ப தி ப் பி த ்த ல் 

•	 அட்டவணைத்தாளில் வரிசை /நெடுவரிசைகளை 

கையாளுதல் 

•	 உரை வடிவூட்டலின் பல்வேறு விருப்பங்களை 

அறிந்துக�ொள்ளுதல் 

•	 அட்டவணைத்தாளில் எண் வடிவூட்டலின் 

பயன்பாடு

9.1 அட்டவணைச் செயலி ஓர் அறிமுகம்

	 அட்டவணைச்செயலி அலுவலக 

பயன்பாட்டிற்குத் தேவையான தரவுகளை 

ஒருங்கிணைத்து, ஆராய்ந்து, சேமித்து 

அட்டவணை வடிவில் தருவதற்கு பயன்படும் மிகச் 

சிறந்த கருவியாகும். கைவழி கணக்கீடுகளைச் 

செய்ய உதவும் கணக்கீட்டு தாள்களுக்கு 

இணையாக கணினியில் கணக்கீடுகளைச் 

செய்வதற்கு ஏதுவாக அட்டவணைச்செயலி 

உ ரு வ ா க ்கப்பட்    டு ள்ள  து .

	 அட்டவணைச்செயலியில் தேக்கி 

வைத்த எந்த ஒரு மதிப்பையும் பயனர் மாற்றி 

அமைத்துக்கொள்ளமுடியும். இதன் மூலம் ஏற்படும் 

விளைவுகளினால் கணக்கீட்டு மதிப்புகளில் ஏற்படும் 

மாற்றத்தையும் பயனர் அறியலாம். இதுவே ”என்ன 
– எனில் பகுப்பாய்வு” (What – if analysis) எனப்படும்.

	ந வீன அட்டவணைச் செயலியில் 

தரவுகளை உரை அல்லது எண் அல்லது வரைபட 

வடிவில் தரமுடியும்; மேலும் ஒன்றுக்கு மேற்பட்ட 

அட்டவணைத் தாள்களை ஒருங்கிணைத்து 

அவற்றில் செயலாற்ற முடியும்.

9.1.1 அட்டவணைச் செயலியின் வளர்ச்சி

	டே னியல் பிரிக்லின் மற்றும் பாப் 

ஃப்ராங்ஸ்டன் ஆகிய�ோர், 1979- ஆம் ஆண்டு, 

ஆப்பிள் II என்ற கணிப்பொறிக்காக, விசிகால்க் 
(Visicalc) என்ற முதல் அட்டவணைச்செயலியை 

உருவாக்கினார்கள். அதன் பின்னர், ல�ோட்டஸ் 
கார்ப்ரேசன் (Lotus Corporation) என்ற நிறுவனம் 

ல�ோட்டஸ் 1-2-3 (Lotus 1-2-3) என்ற 

அட்டவணைச்செயலியை, 1982ஆம் ஆண்டு 

உருவாக்கியது. நுண்ணறைகளுக்கு பெயரிடுதல் 

மற்றும் மேக்ரோஸ் ப�ோன்றவை ”ல�ோட்டஸ் 1-2-3”-

ல் முதன் முதலில் அறிமுகப்படுத்தப்பட்டது. 1987-ல் 

மைக்ரோ சாப்ட் நிறுவனம் எக்ஸெல் (Excel) என்ற 

அட்டவணைச்செயலியை அறிமுகப்படுத்தியது. 

சுட்டியைப் பயன்படுத்தும் வரைகலை பயனர் 

இடைமுகம் (GUI - Graphical User Interface) 

வசதி எக்ஸெல் அட்டவணைச் செயலியில் 

செயல்படுத்தப்பட்டது. பல்வேறு  வகையான 

அட்டவணைச்செயலி மென் ப�ொருள்களில் 

இருந்தப�ோதிலும், மைக்ரோ சாப்ட் எக்ஸெல் மிகவும் 

பிரபலமான ஒன்றாகும்.

பாடம் 9அலகு III அட்டவணைச் செயலி

அட்டவணைச் செயலி
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அட்டவணைசெயலியின் தந்தை – 

டேனியல் சிங்கர் “டான் பிரிக்ளின்”

முதல் அட்டவணைச் 

ச ெ ய லி ய ா ன 

“விசிகால்க்”-யை உருவாக்கிய 

டான் பிரிக்லின் மற்றும் பாப் 

ஃப்ராங்ஸ்டன் ஆகிய இருவரில், 

1951 ஜூலை 16ல் பிறந்த, டேனியல் சிங்கர் டான் 

பிரிக்ளின் "அட்டவணைச்செயலியின் தந்தை" என 

அழைக்கபடுகிறார். டான் பிரிக்ளின் சாஃப்ட்வேர் 

கார்டன் (Software Garden Inc.) என்ற நிறுவனத்தை 

உருவாக்கி அதற்கு தலைவராகவும் உள்ளார். மேலும் 

web.com-க்கு ச�ொந்தமான டெரிலிக்ஸ் கார்ப்பரேசன் 

(Trellix Corporation) என்ற நிறுவனத்திற்கும் 

தலைவராக உள்ளார். தற்போது, ஆல்ஃபா சாப்ட்வேர் 

(Alpha software) என்ற நிறுவனத்தின் ”தலைமை 

த�ொழில் நுட்ப அதிகாரி”-யாகவும் 

பணியாற்றிவருகிறார்.

	 ஒபன் ஆஃபீஸ் கால்க் ஒரு பிரபலமான 

திறந்த மூல (Open Source) அட்டவணைச்செயலி 

ஆகும். இதனை தற்போது அபாச்சி (Apache) 
நிறுவனம் நிர்வகித்து வருகிறது. 1985-ல் ஜெர்மன் 

நிறுவனமான ஸ்டார் டிவிஷன் (Star Division) 
உருவாக்கிய ஸ்டார் ஆஃபிஸ் கால்க் (Star Office 
Calc), ஒபன் ஆஃபிஸ் கால்கின் (Open Office Calc) 

மூல பயன்பாடாகும்.

9.2. ஒபன் ஆஃபீஸ் கால்க்-ல் வேலை செய்தல்.

	 கால்க்(Calc) என்பது ஓபன் 

ஆஃபீஸ் (Open Office) த�ொகுப்பில் உள்ள 

அட்டவணைச்செயலியாகும். அட்டவணைச் 

செயலியில் எந்த விதமான தரவுகளையும் உள்ளீடாக 

க�ொடுத்து, செயலாக்கம் செய்து, வெளியீட்டை பெற 

முடியும்.  மேலும் “ என்ன-எனில் பகுப்பாய்வு” 
முறையின் மூலம் ஏதேனும் ஒரு தரவை மீண்டும் 

தட்டச்சு செய்யாமல், மாற்றம் மட்டும் செய்தால் 

அவற்றின் வெளியீடுகள் எவ்வாறு மாறுகிறது 

என்பதை எளிதாக பார்க்க முடியும்.

விசிகால்க் 
(Visible 
Calculator) 
என்பது 

ஆப்பிள் II என்ற 
கணிப்பொறிக்காக, விசிகார்ப் என்ற 
நிறுவனத்தால், தனியாள் கணிப்பொறிக்காக 
வடிவமைக்கப்பட்ட முதல் அட்டவணைச்செயலி 
ஆகும். ப�ொழுது ப�ோக்குக்காக சேகரித்தல் 
மற்றும் பயன்படுத்தும் நிலையில் இருந்த 
கணிப்பொறிகளை, தீவிர வணிக ந�ோக்கில் 
கணிப்பொறிகளைப் பயன்படுத்தும் 
வகையில் மாற்றம் பெற “விசிகால்க்” 
முக்கிய பங்காற்றியுள்ளது. அடுத்த இரண்டு 
ஆண்டுகளில் ஐ.பீ.எம் (IBM-PC) தனியாள் 
கணிப்பொறிகளை அறிமுகப்படுத்தியது. ஆறு 
ஆண்டுகளில் ஏழு இலட்சம் பிரதிகள் வரை 
விற்பனை செய்யப்பட்டது, அதன் வரலாற்றில் 
சுமார் 1 மில்லியன் பிரதிகள் வரை விற்பனை 
ச ெ ய ்யப்ப   ட ்ட து .

9.2.1 ஒபன் ஆஃபீஸ் கால்கின் சிறப்பியல்புகள்

எக்ஸெல் அட்டவணைச்செயலியுடன் இணைப்பு: 

ஓபன் ஆஃபீஸ் கால்க் பயன்பாட்டில் மைக்ரோ 
சாப்ட் எச்ஸெல் அட்டவணைச் செயலிகளை 
திறக்கவும், பதிப்பாய்வு செய்யவும் மற்றும் 
சேமிக்கவும் முடியும். 
தானியங்கு கூட்டல் (Autosum)
	 நுண்ணறைத் த�ொகுப்பில் உள்ள 
மதிப்புகளின் கூட்டுத் த�ொகையை கண்டறிய 
உ த வு கி ற து .
பட்டியல்  தானியங்கு நிரப்பி (List Auto Fill):
	 ஒரு பட்டியலின் இறுதியில், சில 
புதிய தரவுகளைச் சேர்க்கும் ப�ோது, 
மற்ற நுண்ணறைகளுக்கு செய்யப்படும் 
வடிவூட்டல்கள், தானாகவே புதிய தரவுகளுக்கும் 
நீ ட் டி க ்கப்ப   டு ம்
தானியங்கு நிரப்பி (Auto Fill):
	தே திகள் அல்லது எண்கள் வரிசை 
முறை அல்லது மீண்டும், மீண்டும் த�ோன்ற 
வேண்டிய உரைகளை தேர்ந்தெடுக்கப்பட்ட  
நுண்ணறைகளில் விரைவாக த�ோன்ற செய்ய 
தானியங்கு நிரப்பி வசதி வகை செய்கிறது. 
செயற்கூறுகளை நகலெடுக்கவும் இவ்வசதி 
பயன்படுகிறது. மேலும் இதன் மூலம் உரை 
மற்றும் எண்களை மாற்றி அமைக்க முடியும்.
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விளக்கப்படம் (Charts):
	தர வுகளை வட்ட (Pie), பட்டை (Bar), 
க�ோட்டு (Line) ப�ோன்ற  விளக்கப்படங்களாக 
தருவதற்கு பயன்படுகிறது. 

செயற்கூறுகள் (Functions):
	தர வுகளின் மீது, சிக்கலான கணக்கீடுகளைச் 
செய்ய உதவும் வாய்பாடுகளை உருவாக்க பயன்படுகிறது.

தரவுத்தள செயற்கூறுகள் (Database functions)
	தர வுகளை ஒழுங்குபடுத்தி, வடிகட்டி, 
சேமிக்க உதவுகிறது.

 9.3 ஒரு புதிய அட்டவணைத்தாளை 
உருவாக்குதல்

	ஸ்டார்  ஆஃபிஸ் கால்க்-ல் ஒரு புதிய 
அட்டவணைத்தாளை பல்வேறு முறைகளில் 
உ ரு வ ா க ்க ல ா ம் .

விண்டோஸ் முகப்புத் திரையிலிருந்து:

	 Start → All programs→ OpenOffice → 
OpenOffice Calc 

(அல்லது)
ஸ்டார் சென்டர் (ஒபன் ஆஃபீஸ் வரவேற்பு திரை)-
லிருந்து

•	 விண்டோஸ் திரைமுகப்பிலுள்ள “Open Office“ 
பணிக்குறியை இருமுறை கிளிக் செய்யவும்.

•	 இப்போது, படம் 9.1 ல் உள்ளது ப�ோல ஓபன் 
ஆஃபீஸ் வரவேற்புத் திரை த�ோன்றும்.

ஸ்டார் ஆஃபீஸின் முகப்புத் திரை 
“ஸ்டார் சென்டர்” (Star Center) என்று  
அழைக்கப்படுகிறது். கால்க் ஒபன் ஆஃபிஸின் 
ஒரு உள்ளிணைந்த பகுதியாகும். எனவே, 
இதனை ஸ்டார் சென்டரில் உள்ள "Spreadsheet" 
பணிக்குறியை கிளிக் செய்வதன் மூலம் எளிதாக 
பெறலாம்.

(அல்லது)
	 ஒபன் ஆஃபிஸின் எந்த ஒரு 
பயன்பாட்டிலிருந்தும்  File→ New→ Spreadsheet 
என்ற கட்டளையின் மூலமும் ஒரு புதிய 
அட்டவணைச் செயலியை உருவாக்கலாம்.

	மேலே  விவரிக்கப்பட்ட ஏதேனும் ஒரு 
வழிமுறைப் பயன்படுத்தி ஒபன் ஆஃபீஸ் கால்க்-ஐ 

திறக்கும் ப�ோது, படம் 9.2ல் காட்டப்பட்டுள்ளபடி 
சன்னல் திரை த�ோன்றும். கால்க்-ன் வெளிப்புற 
சன்னல் திரை, மற்ற ஒபன் ஆஃபீஸ் சன்னல் 
திரையை ப�ோன்றே இருக்கும். கால்க் சன்னல் 
திரையின் முக்கியப் பகுதி பணிப் பகுதி (Work 
area) அல்லது அட்டவணைத் தாள் (Worksheet) 
என்று அழைக்கப்படுகிறது. 

	 அட்டவணைத்தாள் என்பது 
கட்டங்களுடன் கூடிய நுண்ணறைகளைக் 
க�ொண்ட ஒரு அமைப்பு ஆகும். அதன் 
ஒவ்வொறு நுண்ணறையிலும் நிரலாக்கப்பட்ட 
கணிப்பாண்கள் இணைந்துள்ளது. ஒரு புதிய 
அட்டவணைச்செயலியை திறக்கும் ப�ோது, 
க�ொடாநிலையாக மூன்று அட்டவணைத்தாள்களே 
இருக்கும். தேவையெனில் இன்னும் அதிகமான 
அட்டவணைத்தாள்கள் சேர்த்துக்கொண்டு, 
ஒருங்கிணைக்கவும் முடியும்.

 
படம் 9.1 ஒபன் ஆஃபீஸ் முகப்புத் திரை 

(ஸ்டார் சென்டர்)
1

11
10

9

5 6 7 4

3 2

8

1.  தலைப்புப் பட்டை
(Title bar)

2. கட்டுப்பாட்டு ப�ொத்தான்கள்
(Control Buttons)

3. பட்டிப் பட்டை 
(Menu bar)

4.  கருவிப் பட்டை
(Tool bar)

5.  பெயர் பெட்டி / முகவரிப் 
பெட்டி (Name Box / 
Address Box) 

6.  விரைவு செயற்கூறு வழிகாட்டி 
(Quick Function Wizard)

7.  வாய்பாடுப் பட்டை / 
உள்ளீட்டுப் பெட்டி 
(Formula bar / Input Line)

8.  வடிவூட்டல் பண்புகள் 
(Formatting properties)
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9.  பெரிதாக்குதல் 
(Zoom)

10.   உருள் பட்டை 
(Scroll bar)

11.   நிலைமைப் பட்டை 
(Status bar)

படம் 9.2 ஒபன் ஆஃபீஸ் கால்க் சன்னல் திரை

9.3.1  �ஒபன் ஆஃபீஸ்  கால்க் சன்னல் திரையின் 
பகுதிகள் 

	 கால்க்–ன் சன்னல் திரை, முந்தைய 
பாடத்தில் கற்ற  ச�ொற்செயலியின் சன்னல் 
திரை ப�ோன்றே த�ோற்றமளிக்கும். ரைட்டரில் 
தட்டச்சு செய்யப்பட வேண்டிய காலியான 
வெற்றிடம் அதன் பணித்தளம் ஆகும். ஆனால் 
கால்க் – ல் பணித்தளம் கட்டங்களுடன் கூடிய 
நுண்ணறைகளாக இருக்கும்.
9.3.1.1 தலைப்புப் பட்டை

	 சன்னல் திரையி்ன் மேல்பக்கம், 
தலைப்புப் பட்டை என்று அழைக்கப்படுகிறது. 
இது பயன்பாட்டின் பெயரையும், அதன் மூலம் 
உருவாக்கப்படும் க�ோப்பின் பெயரையும் காட்டும். 
ஒபன் ஆஃபீஸ் கால்க்கில், ஒரு அட்டவணை 
சேமிக்கப்படாத நிலையில் க�ொடாநிலையாக 	
Untitled1 என்று பெயரிடப்பட்டிருக்கும்.

9.3.1.2 கட்டுப்பாட்டுப் ப�ொத்தான்கள்

	 தலைப்புப் பட்டையின் வலது ஓரத்தில் 
மூன்று கட்டுப்பாட்டு ப�ொத்தான்கள் உள்ளது. 
அவை, (1) சிறிதாக்கு (2) பெரிதாக்கு / மீட்டமை 
மற்றும் (3) மூடு ப�ொத்தான்கள்.

9.3.1.3 பட்டிப்பட்டை

	 தலைப்புப் பட்டைக்கு கீழே உள்ளது, 
பட்டிப்பட்டை ஆகும். பெரும்பான்மையான 
பட்டியல்கள் (Menu), ஒபன் ஆஃபீஸ் ரைட்டரில் 
உள்ளது ப�ோன்றே இருக்கும்.  
	 File: இந்த பட்டி, க�ோப்பு மேலாண்மை 
கட்டளைகளான, ஒரு புதிய க�ோப்பை 
உருவாக்குதல் (New), ஏற்கனவே 
உருவாக்கப்பட்ட க�ோப்புகளைத் திறத்தல் 
(Open), நடப்பு க�ோப்பை மூடுதல் (Close), ஒரு 
க�ோப்பை சேமித்தல் (Save), ஒரு க�ோப்பை 
வேறு பெயரில் சேமித்தல் (SaveAs), அச்சிடுதல் 
(Print), ஒரு க�ோப்பை ஒரு முறைமையிலிருந்து, 
மற்றொரு முறைமைக்கு மாற்றுதல் (Export) 
ப�ோன்ற செயல்களைச்   செய்வதற்கான 
கட்டளைகளைக் க�ொண்டுள்ளது.

	 Edit:  வெட்டுதல் (Cut), நகலெடுத்தல் 
(Copy), ஒட்டுதல் (Paste), திரும்பப் பெறு 
(Undo), மீண்டும் செய் (Redo), நிரப்பு (Fill) 
ப�ோன்ற அட்டவணைச் செயலியைப் பகுப்பாய்வு 

செய்வதற்கான கட்டளைகளைக் க�ொண்டுள்ளது. 
பெரும்பான்மையான கட்டளைகள் ரைட்டர் Edit 
பட்டியில் உள்ளத�ோடு ஒத்திருப்பினும், கால்க்கின் 
சிறப்பு பதிப்பாய்வு கட்டளைகளையும், இந்த பட்டி 
க�ொண்டுள்ளது.

	 View: கால்க்-ன் பணிச்சூழலை மாற்றி 
த�ோன்ற செய்யப் பயன்படும் கட்டளைகளை 
இப்பட்டி க�ொண்டுள்ளது. 

	 Insert:  நுண்ணறைகள் (Cells), 
வரிசைகள் (Rows), நெடுவரிசைகள் (Columns), 
செயற்கூறுகள் (Functions), விளக்கப்படங்கள் 
(Charts) ப�ோன்ற கால்க்கின் முக்கிய கூறுகளைச் 
செருக தேவையான கட்டளைகளை இந்தப் பட்டி 
க�ொண்டுள்ளது.

	 Format: உரை மற்றும் நுண்ணறைகளை 
வடிவூட்டம் செய்யப் பயன்படும் பல்வேறு 
கட்டளைகளை க�ொண்டுள்ளது.

	 Tools: ச�ொற் பிழைத் திருத்தம் 
(Spell check), ஆவணப் பாதுகாப்பு (Protect 
document), படங்களை இணைத்தல் (Insert 
pictures), மேக்ரோ (Macro) ப�ோன்ற பல்வேறு 
கருவிகளையும், செயற்கூறுகளையும் இப்பட்டி 
க �ொ  ண் டு ள்ள  து .

	 Data: வரிசையாக்கல் (Sort), 
வடிகட்டல் (Filter), கூட்டுத்தொகை (Subtotal), 
செல்லுபடியாக்கல் (Validity) ப�ோன்ற தரவு 
கையாளுகைக்கு பயன்படும் கட்டளைகளை 
இப்பட்டி க�ொண்டுள்ளது.

	 Window:	 புதிய சன்னல் (New 
Window), சன்னலை மூடுதல் (Close Window), 
சன்னல் பிரித்தல் மற்றும் உறைதல் (Split and 
Freeze) ப�ோன்ற காட்சி விருப்பத் தேர்வுகளை 
இப்பட்டி க�ொண்டுள்ளது.

	 Help: ஒபன் ஆஃபீஸ் பயன்பாட்டுடன் 
இணைந்துள்ள உதவி-யைப் பெறுவதற்கு இப்பட்டி 
ப ய ன்ப  டு கி ற து .
9.3.1.4 கருவிப்பட்டை (Tool bar)
	 பட்டிப்பட்டையின் கீழ் க�ொடா நிலையாக 
மூன்று கருவிப்பட்டைகள் உள்ளன. அவை

1.	 செந்தாரக் கருவிப்பட்டை 

2.	 வடிவூட்டல் கருவிப்பட்டை

3.	 வாய்ப்பட்டு பட்டை
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செந்தரக் கருவிப்பட்டை (Standard Tool bar)

வடிவூட்டல் கருவிப்பட்டை(Formatting Tool bar) வாய்ப்பாட்டு பட்டை (Formula bar)
படம் 9.3 ஒபன் ஆஃபீஸ் கால்க் கருவிப்பட்டைகள்

	 செந்தரக் கருவிப்பட்டை – இந்தப் பட்டை, 
File, Edit மற்றும் Data ஆகிய பட்டிப்பட்டையிலுள்ள, 
அடிக்கடி பயன்படுத்தப்படும் கட்டளைகளான, 
New (ஒரு புதிய க�ோப்பை உருவாக்குதல்), Open 
(ஏற்கனவே உள்ள க�ோப்பை திறத்தல்), Save 
(சேமித்தல்), Send (பரிமாற்றம் செய்தல்), Print 
(அச்சிடுதல்), Print preview (அச்சு முன்பார்வை), 
Cut (வெட்டுதல்), Copy (நகலெடுத்தல்), Paste 
(ஒட்டுதல்), Sorting (வரிசையாக்கம்), Inserting 
Chart (விளக்கப்படம் செருகுதல்) ப�ோன்றவற்றை 
பணிக்குறிகளாக (Icons) க�ொண்டுள்ளது.
	 வடிவூட்டல் கருவிப்பட்டை – உரை 
மற்றும் நுண்ணறைகளை வடிவூட்டல் செய்யும் 
கட்டளைகளான, எழுத்துரு வகை (Font 
Style), அளவு (Size), நிறம் (Colour), இசைவு 
(Alignment), நுண்ணறை வடிவூட்டல்கள் (Cell 
Formatting) ப�ோன்றவற்றை பணிக்குறிகளாக 
இந்த கருவிப்பட்டை க�ொண்டுள்ளது. 
	 வாய்பாட்டுப் பட்டை:– ஒரு அட்டவணைச் 
செயலியின் மிக முக்கியமான கூறு, வாய்பாட்டுப் 
ஆகும். இந்தப் பட்டை, பெயர் பெட்டி (Name 
box), செயற்கூறு வழிகாட்டி (Function 
Wizard), கூட்டல் ப�ொத்தான் (Sum button), 
செயற்கூறு ப�ொத்தான் (Function button) மற்றும் 
உள்ளீட்டுத்தாரை (Input Line) ஆகியவற்றை 
க�ொண்டுள்ளது. (படம் 9.4ஐ பார்க்க).
	 பெயர் பெட்டி  (Name Box ):
	 இது நடப்பு நுண்ணறையின் முகவரியை 
க ாட்  டு ம்
	 செயற்கூறு வழிகாட்டி (Function 
Wizard):  செயற்கூறுகளை சேர்க்க உதவுகிறது
	 கூட்டல் ப�ொத்தான் (Sum button): 
கூட்டல் செயற்கூற்றை விரைவாக செருக இது 
உ த வு கி ற து .
	 உள்ளீட்டுத்தாரை (Input line): நடப்பு 
நுண்ணறையில் உள்ள தரவுகளைக் காட்ட இது 
பயன்படுகிறது. இது ஒரு நுண்ணறையில் பயனர் 
எதைத் தட்டச்சு செய்தார�ோ அதனை மட்டுமே 
காட்டும். மேலும், இது நுண்ணறையில் உள்ள 
தரவுகளை பதிப்பிக்கவும் பயன்படுகிறது.

பெயர் பெட்டி / முகவரி பெட்டி
உள்ளீட்டு தாரை

Sum ப�ொத்தான்

செயற்கூறு 
வழிகாட்டி

செயற்கூறு 
ப�ொத்தான்

படம் 9.4 கால்க் வாய்ப்பாடுப் பட்டை

9.3.1.5 திரை உருளல் பட்டை (Scroll bar)
	 அட்டவணைச்செயலி சன்னல் திரை 
இரண்டு விதமான திரை உருளல் பட்டைகளைக் 
க�ொண்டுள்ளது. அவை (1) நெடுங்கிடை திரை 
உருளல் (Vertical Scroll bar) மற்றும் (2) 
படுக்கிடை திரை உருளல் பட்டை (Horizontal 
Scrollbar). (படம் 9.5-யை காண்க)
நெடுங்கிடை திரை உருளல் பட்டை: இது திரையை 
மேல் மற்றும் கீழாக நகர்த்த உதவுகிறது.
படுக்கிடை திரை உருளல் பட்டை: இது திரையை 
வலது மற்றும் இடது புறமாக நகர்த்த உதவுகிறது..
திரை உருளல் ப�ொத்தான்கள் (Scroll buttons) 
திரையைத் தேவையான அளவிற்கு நகர்த்த இது 
உதவுகிறது.

மேல் உருளல் 
அம்புக்குறி

உருளல் ப�ொத்தான்

கீழ் உருளல் 
அம்புக்குறி

வலது உருளல் 
அம்புக்குறி

உருளல் ப�ொத்தான்இடது உருளல் 
அம்புக்குறி

நெடுங்கிடை திரை 
உருளல் பட்டை

படுக்கிடை திரை உருளல் பட்டை

படம் 9.5 கால்க் திரைஉருளல் பட்டை
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9.3.1.6 வரிசை (Row), நெடுவரிசை (Column), 
நுண்ணறை (Cell) மற்றும் நுண்ணறை சுட்டி 
(Cell Pointer):

	 வாய்ப்பாட்டுப் பட்டையின் 
கீழே வரிசைகளும், நெடுவரிசைகளும் 
இணைந்த கட்டங்களான அட்டவணைத் 
தாளின் பணித்தளம் அமைந்துள்ளது. 
அட்டவணைத்தாள், ஒரு குறிப்பிட்ட 
எண்ணிக்கையிலான வரிசைகளையும், 
நெடுவரிசைகளையும் க�ொண்டிருக்கும். 
ஒவ்வொரு நெடுவரிசையும், A, B, C, D 
…….. AA, AB, AC …… என்ற வகையில் 
பெயரிடப்பட்டிருக்கும். வரிசைகள் 
ஒவ்வொன்றுக்கும் 1, 2, 3  ……. என 
எண்ணிடப்பட்டிருக்கும். (படம் 9.6-யை காண்க).

	 ஒபன் ஆஃபீஸ் கால்க் பதிப்பு 4.1.5 
ம�ொத்தம் 1024 நெடுவரிசைகளையும், 10,48,576 
வரிசைகளையும் க�ொண்டுள்ளது. இதன் 
நெடுவரிசைகளின் தலைப்பு (நெடுவரிசை பெயர்) 
ஆங்கில எழுத்தான A-ல் த�ொடங்கி, AMJ-
ல் முடியும். மைக்ரோசாப்ட் ”எக்ஸெல்-2016” 
அட்டவணைச் செயலியை ப�ொருத்தமட்டில், 
ம�ொத்தம் 16,384 நெடுவரிசைகளும் (A முதல் 
XFD வரை), 10,48,576 வரிசைகளையும் 
க �ொண்ட    து .

நுண்ணறை அல்லது கலம் (Cell)
	 ஒரு வரிசையும், நெடுவரிசையும் 
இணையுமிடத்தில் உருவாகும் பெட்டி 
ப�ோன்றத�ொரு அமைப்பு “நுண்ணறை” 
அல்லது “கலம்” என்று அழைக்கப்படுகிறது. 
ஒவ்வொரு நுண்ணறையும் ஒரு தனித்த 

முகவரியை க�ொண்டிருக்கும், அதற்கு 

“நுண்ணறை முகவரி” (Cell Address) என்று 

பெயர். நுண்ணறை முகவரி நெடுவரிசையின் 

பெயரும், வரிசையின் எண்ணும் இணைந்தது.  

எடுத்துக்காட்டாக, B என்ற நெடுவரிசையும், 

வரிசை எண் 4-ம் இணையுமிடத்தில் உருவாகும் 

நுண்ணறையின் முகவரி B4 ஆகும். (படம் 
9.7-யை காண்க) ஒவ்வொரு நுண்ணறையும் 

அதன் தனித்த முகவரியால் அடையாளம் 

க ா ண ப்ப  டு கி ற து .

நுண்ணறைச் சுட்டி (Cell Pointer): 

	 அட்டவணைத்தாள் முழுவதும் நகர்த்தக் 

கூடிய, செவ்வக வடிவிலான பெட்டி ப�ோன்ற 

அமைப்பு “நுண்ணறைச் சுட்டி” என்று 

அழைக்கப்படுகிறது. எந்த நுண்ணறையில் 

நுண்ணறை சுட்டி தற்போது உள்ளத�ோ, அந்த 

நுண்ணறை ”செயற்படு கலம்” (Active Cell) 

எனப்படும். தட்டச்சு செய்யப்படும் எந்த ஒரு 

தரவும், இந்த செயற்படு கலத்தினில் த�ோன்றும். 

செயற்படு கலத்தின் நுண்ணறை முகவரி, பெயர் 

பெட்டி முகவரி பெட்டியில் த�ோன்றும். செயற்படு 

கலத்தின் நெடுவரிசை பெயரும், வரிசை எண்ணும் 

வேறு நிறத்தில் உயர்த்திக் காட்டப்பட்டிருக்கும் 

(Highlighted). இந்த ஒரு காட்சிக் குறிப்பை 

(Visual Clue) வைத்து, செயற்படு கலனை 

எளிதில் அடையாளம் காணலாம். மேலும், 

செயற்படு கலத்திலுள்ள தரவுகள் வாய்ப்பாட்டு 

பட்டையின் த�ோன்றும். 

வ
ரி

சை


 எ
ண்க


ள்

நெடுவரிசை தலைப்புகள்

நுண்ணறை சுட்டி

நுண்ணறைகள்

 படம்  9.6 நுண்ணறை, வரிசை மற்றும் நெடுவரிசை 
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நடப்பு நுண்ணறை முகவரி உயர்த்திகாட்டப்பட்ட நெடுவரிசை தலைப்பு

உயர்த்திகாட்டப்பட்ட வரிசை எண்

செயல்படு கலம்

 படம்  9.7 நுண்ணறை, வரிசை மற்றும் நெடுவரிசை 

9.3.1.7 அட்டவணைத் தத்தல்கள்
செயல்படு தாள்

தாள்களின் எண்ணிக்கை
அட்டவணை தாள் வழிநடத்து 
ப�ொத்தான்கள்

படம் 9.8 கால்க் அட்டவணைத்தாள் தத்தல்கள்

	 நுண்ணறைக் கட்டங்களின் கீழே 

அட்டவணைத்தாள் தத்தல்கள் (Sheet Tabs) 

உள்ளது.   க�ொடாநிலையாக Sheet1, Sheet2  

மற்றும் Sheet3 என்ற பெயரில் மூன்று தாள்கள் 

இருக்கும்.(படம் 9.8-யை காண்க). ஒரு புதிய 

அட்டவணைத் தாளை உருவாக்கும் ப�ோது Sheet 
1 க�ொடாநிலை இயங்கு தாளாக (Default active 
sheet) இருக்கும். இந்த தாள்  தத்தல் வெண்மை 

நிறத்தில் இருக்கும். அடுத்த ஒரு தாளை 

கிளிக் செய்தால், அந்த தாள் இயங்கு தாளாக 

மாறிவிடும், அதன் தத்தலின் நிறம் வெண்மையாக 

மாறும். Ctrl ப�ொத்தானை அழுத்தி பிடித்தவாறு, 

தாள்களின் மீது கிளிக் செய்தால் ஒன்றுக்கும் 

மேற்பட்ட தாள்களை தேர்ந்தெடுக்க முடியும். 

தேர்ந்தெடுக்கப்பட்ட அனைத்து தாள்களின் 

தத்திலின் நிறமும் வெண்மையாக மாறிவிடும். 

	 அட்டவணைத்தாள்களின் தத்தலின் 

இடது பக்கத்தில் உள்ள நான்கு வழிநடத்து 

ப�ொத்தான்களை (Navigation buttons) 

பயன்படுத்தி ஒரு தாளில் இருந்து மற்றொரு 

தாளிற்கு நகரமுடியும்.

1 3

2 4

படம் 9.9 அட்டவணைத்தாள் வழிநடத்து 

ப�ொத்தான்கள்
1.	 முதல் தாளிற்கு நகர

2.	 முந்தைய தாளிற்கு நகர

3.	 அடுத்த தாளிற்கு நகர
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4.	 கடைசி தாளிற்கு நகர

	 நிலைமைப் பட்டையின் இடது 
ஓரத்தில், நடப்பு அட்டவணைச்செயலியில் 
உள்ள ம�ொத்த தாள்களின் எண்ணிக்கையும், 
நடப்பு இயங்கு தாளின் வரிசை எண்ணும் 
க�ொடுக்கப்பட்டிருக்கும். எடுத்துக்காட்டாக, 
நிலைமை பட்டையில் 3/12 எனக் காணப்பட்டால், 
நடப்பு அட்டவணைச்செயலியில் ம�ொத்தம் 12 
தாள்கள் உள்ளது எனவும், அதில் 3வது தாள் 
இயங்கு தாளாக உள்ளது என்றும் ப�ொருள்.

	 அட்டவணைத்தாளின் ஒவ்வொரு 
தாளின் பெயரையும் மாற்ற முடியும். ஒரு தாளிற்கு 
மாற்றுப் பெயரிட, அந்த தாளின் மீது இருமுறை 
கிளிக் செய்யவும். இப்போது படம் 9.10ல் 
காட்டப்பட்டுள்ளது ப�ோன்று, Rename Sheet 
உரையாடல் பெட்டி த�ோன்றும்.

படம் 9.10 மாற்றுப்பெயரிடல் உரையாடல் பெட்டி

	 இது, அட்டவணைத்தாளின் 
தற்போதைய பெயரை Name உரை பெட்டியில் 
காட்டும். காட்டப்படும் பெயரை அழித்துவிட்டு 
அல்லது அதன்மீது நேரடியாக புதிய பெயரை 
தட்டச்சு செய்து, OK ப�ொத்தானை கிளிக் 
செய்ய வேண்டும். இப்போது, புதிய பெயர் தாளில் 
த�  ோ ன் று ம் . 
9.3.1.8 நிலைமைப் பட்டை (Status bar)
	 அட்டவணைத்தாள்கள் மற்றும் 
படுக்கிடை திரைஉருள் பட்டையின் கீழ் உள்ள 
பகுதி, நிலைமைப் பட்டை எனப்படும். இது 
அட்டவணைத்தாளின் நடப்பு நிலைமையை 

காண்பிக்கும். (படம் 9.11-யை காண்க) 
	தாள்க ளின் எண்ணிக்கை (Sheets 
Count): நடப்பு தாளின் வரிசை எண் மற்றும் 
ம�ொத்த தாள்களின் எண்ணிக்கையை காட்டும்.
	 பக்க அமைப்பு (Page Style):நடப்பு 
அட்டவணைத்தாளின் பக்க அமைப்பை 
காட்டும். அதில் ஏதேனும் மாற்றம் செய்ய 
விரும்பினால், “Default” என்பதன் மீது 
இருகிளிக் செய்யவும், இப்போது “பக்க அமைப்பு 
உரையாடல் பெட்டி” (Page Style dialog box) 
த�ோன்றும். அதில், பக்கத்தின் ஓரம் (Margin), 
அமைவு (Orientation), பக்க அளவு (Page 
Size), தலைப்பு (Header), அடிக்குறிப்பு 
(Footer), எல்லை அமைப்பு (Border Style) 
ப�ோன்றவற்றை மாற்றிக்கொள்ள முடியும்

தேர்ந்தெடுப்பு நிலை (Selection mode): நடப்பு 
தாளின் தேர்ந்தெடுப்பு நிலையை காட்டும். 
அட்டவணைத்தாளின் நுண்ணறைகளை 
தேர்ந்தெடுப்பதற்கு மூன்று நிலைகள் உள்ளது. 
அவை, Standard (STD), Entend (EXT) 
மற்றும் Add (ADD).
சேமிக்கப்படாத மாற்றங்கள் (Unsaved 
Changes) நிலைமைப்பட்டையில் * என்ற குறியீடு 
த�ோன்றினால் அட்டவணைத்தாள்களில் 
செய்யப்பட்ட மாற்றங்கள், சேமிக்கப்படாமல் 
உள்ளது என்பதை குறிக்கும். பயனர் 
அட்டவணைத்தாளை சேமிக்கும்போது இந்த 
குறி மறைந்துவிடும்.

நுண்ணறைத்தகவல் (Cell Information):
தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளில் உள்ள 
மதிப்புகளின் கூட்டுத்தொகையை காண்பிக்கும்.

பெரிதாக்கு நகர்வி (Zoom slider):இது 
பார்வையிடு அளவுக�ோலை (View  Scale) மிகுக்க 
(அல்லது) குறைக்க உதவும்.  க�ொடாநிலையாக 

பெரிதாக்கு  அளவுக�ோலின் அளவு 100% ஆகும்.

தாள்களின் எண்ணிக்கை

பக்க வடிவமைப்பு சேமிக்கப்படாத மாற்றங்கள் நுண்ணறை தகவல்கள்

தேர்ந்தெடுப்பு நிலை பெரிதாக்கு நகர்வி

படம் 9.11 கால்க் நிலைமை பட்டை
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9.4 தரவுகளுடன் வேலை செய்தல்
	 ஒரு புதிய அட்டவணைத்தாளைத் 
திறக்கும்போது, நுண்ணறைச் சுட்டி, A1 
நுண்ணறையில் நிலைக்கொண்டிருக்கும். 
எனவே, A1 நுண்ணறை “Home Cell” 
என்று அழைக்கப்படும். விசைப்பலகையில் 
உள்ள திசைப்பொத்தான்களைப் பயன்படுத்தி, 
நுண்ணறைச் சுட்டியை அட்டவணைத்தாளின் 
எந்த ஒரு பகுதிக்கும் நகரத்தலாம்.

விசைப்பலகையில் உள்ள Tab ப�ொத்தான், 
நுண்ணறைச் சுட்டியை முன்னோக்கி அதாவது 
இடமிருந்து    வலப்பக்கமாக    நகர்த்தும். Shift 
+ Tab ப�ொத்தான், பின்னோக்கி அதாவது, 
வலமிருந்து இடமாக நகர்த்தும். Enter ப�ொத்தானும் 
நுண்ணறையை நகர்த்தப் பயன்படுகிறது. Enter 
ப�ொத்தானை அழுத்தும் ப�ோது, நுண்ணறைச் 
சுட்டி, நடப்பு நுண்ணறையிலிருந்து கீழ்நோக்கி 
நகர்த்தப்படும். நான்கு திசைப்பொத்தான்களும் 
நுண்ணறை சுட்டியை எந்த திசையில் 
வேண்டுமானாலும் நகர்த்தும்.

9.4.1 தரவினை உள்ளீடுதல்

	 அட்டவணைத்தாளில் எந்த ஒரு 
நுண்ணறையிலும் எந்த ஒரு தரவினையும் தட்டச்சு 
செய்ய முடியும். ஆனால், தட்டச்சு செய்யப்பட 
வேண்டிய நுண்ணறை செயற்படு கலமாக 
(Active cell) இருத்தல் வேண்டும். எனவே, எந்த 
நுண்ணறையில் தரவினை உள்ளீட வேண்டும�ோ 
அந்த நுண்ணறைக்கு நுண்ணறைச் சுட்டியை 
நகர்த்தி அல்லது அந்த நுண்ணறையைக் கிளிக் 
செய்து அதை செயற்படு நுண்ணறையாக (Active 
Cell) மாற்ற வேண்டும். இதில் தேவையான 
தரவுகளைப் பயனர் தட்டச்சு செய்யலாம். பயனர் 
தரவினை பின்னர், எந்த ஒரு தரவையும் தட்டச்சு 
செய்ய த�ொடங்கலாம். தரவை நுண்ணறையில் 
தட்டச்சு செய்யும் ப�ொழுது அது எந்த வகை 
தரவினம் என்பதை அறிந்து க�ொள்ளும் திறன் 
அட்டவணைச்செயலிக்கு உள்ளது.

தரவு வகைகள்

	 தரவுகள் பல வகைப்படும். தரவுகள் 
எண்களாகவ�ோ, எழுத்துக்களாகவ�ோ தேதி 
மற்றும் நேரம் ப�ோன்றவையும் மற்றொரு வகை 
தரவு இனமாகும். ப�ொதுவாக தரவு வகைகளைப் 
பின்வருமாறு பிரிக்கலாம்.

எழுத்து தரவினம் (Alphabetic data type) - 
எழுத்துக்களை மட்டும் க�ொண்டிருக்கும்

எண்ணுரு தரவினம் (Numeric data type)- 

எண்களை மட்டும் க�ொண்டிருக்கும் (முழு 
எண்கள் அல்லது மிதப்புப் புள்ளி எண்கள்)

எண்ணெழுத்து தரவினம் (Alphanumeric 
data type) - எழுத்துக்கள் மற்றும் எண்களின் 
த�ொகுப்பு

தேதி தரவினம் (Date data type) - தேதிகளை 
மட்டுமே க�ொண்டிருக்கும்.

நேரம் தரவினம் (Time data type) - நேரத்தை 
மட்டுமே க�ொண்டிருக்கும்.

9.4.1.1 எண்களை உள்ளிடுதல்

	 எந்த எண்ணுரு தரவுகளையும் 
அட்டவணைத்தாளில் உள்ளிட முடியும். 
உள்ளிடப்படும் எண்கள் க�ொடாநிலையாக 
நுண்ணறையில் வலது பக்க இசைவில் தான் 
அமையும். ஒரு எண்ணை எதிர்மறை எண்ணாக 
உள்ளிட, அதன் முன்னொட்டாக எதிர்மறை 
குறியீட்டை (-) பயன்படுத்தலாம் அல்லது அந்த 
எண்ணை அடைப்புக்குறிக்குள் ( ) க�ொடுக்கலாம். 
அடைப்புக்குறிக்குள் ஒரு நேர்மறை எண் 
உள்ளிடப்பட்டால், அது எதிர்மறை எண்ணாக 
மாற்றபட்டு அதன் முன்னொட்டாக (–) குறியீடு 
சேர்க்கப்படும். ஏதேனும் ஒரு எண் சுழியத்தில் 
(0) த�ொடங்கினால், கால்க் அதன் சுழியத்தை 

நீக்கிவிடும். (படம் 9.12 காண்க)

படம் 9.12 தரவுகளை உள்ளீடல்

9.4.1.2 உரையை உள்ளிடுதல்

	 கால்க்-ல் எண்களைப் ப�ோல் எந்த ஒரு 

எழுத்துருவையும் தரவாக உள்ளீடு செய்ய முடியும். 

உள்ளீடு செய்யப்பட்ட உரை க�ொடாநிலையாக 

நுண்ணறையின் இடது இசைவில் தான் அமையும். 

ஏதேனும் ஒரு எண்ணுரு உள்ளீடு செய்யப்பட்டு, 

அது நுண்ணறையின் இடது பக்க இசைவில் 

இருத்தப்பட்டால், உள்ளீடு செய்யப்பட்ட எண்ணை 

கால்க் ஒரு எண்ணுருவாக கருதவில்லை 

என புரிந்துக�ொள்ளலாம். ஒரு எண்ணுருவை, 

எழுத்துருவாக மாற்ற, உள்ளிடப்படும் எண் ஒற்றை 

மேற்கோள் குறியுடன் த�ொடங்க வேண்டும்.  (படம் 

9.13 காண்க)
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படம் 9.13 உரையை உள்ளிடுதல்

9.4.1.3 தேதி மற்றும் நேரம் உள்ளிடுதல்

	 ஒபன் ஆஃபீஸ் கால்க்-ல் தேதியை 
உள்ளீடு செய்வதற்கு முன், கணிப்பொறியின் 
அமைப்பு தேதி வடிவமைப்பை (System date 
format) உறுதி செய்து க�ொள்ளவேண்டும்.  
ஏனெனில், கால்க் கணிப்பொறி அமைப்பு தேதி 
வடிவமைப்பில் மட்டுமே உள்ளிடப்படும் தேதியை 
ஏற்றுக் க�ொள்ளும். கணிப்பொறி, அமெரிக்க 
தேதி வடிவமைப்பை (மாதம்-தேதி-ஆண்டு) 
க�ொண்டிருந்தால், அதே வடிமைப்பில் அதாவது, 
MM/DD/YY என்று தான் கால்க்-ல் தேதி 
உள்ளிடப்பட வேண்டும். ஒருவேளை கணிப்பொறி 
இந்திய தேதி வடிவமைப்பில் இருந்தால், 
DD/MM/YY என்று தேதி உள்ளிடப்பட 
வேண்டும். கால்க் கணிப்பொறியின் நடப்பு 
தேதி முறைமையை மட்டுமே ஏற்றுக்கொள்ளும் 
என்பதை நினைவில் க�ொள்க. 

எடுத்துக்காட்டாக: உமது கணிப்பொறியின் 
தேதி வடிவம் அமெரிக்க முறையில் இருந்தால் 
18 டிசம்பர் 2017-யை உள்ளீடு செய்ய 12/18/17 
என்று உள்ளிட வேண்டும். சரியான முறையில் 
உள்ளிடப்பட்ட தேதி அந்த நுண்ணறையின் வலது 
இசைவில் அமையும். அந்த நுண்ணறையில், 
நுண்ணறை சுட்டியை க�ொண்டு சென்றால்  
வாய்ப்பாடு பட்டையில் உள்ளிடப்பட்ட தேதி 
“12/18/2017” என்று த�ோன்றும். உள்ளிடப்பட்ட 
தேதியை கால்க் ஏற்றுக்கொண்டதா இல்லையா 
என்பதை அறிந்துக�ொள்ளமுடியும்.

	 Cell Formatting உரையாடல் பெட்டியின் 

மூலம் தேதி வடிவமைப்பை மற்ற ஏற்கத் தகும் 

வடிவுக்கு மாற்றலாம்.(படம் 9.14 காண்க)

படம் 9.14 தேதி உள்ளிடல்

	 தேதியை ப�ோலவே, நேரத்தை கால்க் 

HH:MM:SS என்ற ப�ொது வடிவில் தான் உள்ளிட 

வேண்டும். இதில் HH என்பது மணி, MM என்பது 

நிமிடம், SS என்பது ந�ொடி என்பதைக் குறிக்கும்.

பல விதமான தேதி வடிவங்கள்

வடிவமைப்பு நாடுகள்

DD/MM/YYYY
ஆசியா (மத்திய, தென்மேற்கு, மேற்கு) ஆஸ்திரேலியா, நியுஸிலாந்து, 
ஐர�ோப்பாவின் சில பகுதிகள், இலத்தீன் அமெரிக்கா, வடக்கு ஆப்ரிக்கா, 
இந்தியா, இந்தோனேஷியா, வங்கதேசம் மற்றும் ரஷ்யா. 

YYYY/MM/DD
பூட்டான், கனடா, சீனா, க�ொரியா, தைவான், ஹங்கேரி, ஈரான், ஜப்பான், 
லித்துவேணியா, மங்கோலியா.

MM/DD/YYYY
அமெரிக்க ஐக்கிய நாடுகள், மைக்ரோநேசியா மாநிலங்கள் கூட்டரசு, மார்சல்  
தீவுகள்.

DD/MM/YYYY 
மற்றும்

MM/DD/YYYY

மலேசியா, நைஜிரியா, பிலிப்பைன்ஸ், சவுதி அரேபியா, ச�ோமாலியா மலேசியா, 
நைஜிரியா, பிலிப்பைன்ஸ், சவுதி அரேபியா, ச�ோமாலியா

DD/MM/YYYY
மற்றும்

YYYY/MM/DD

ஆப்கானிஸ்தான், அல்பேனியா, ஆஸ்தியா, ஜெர்மனி, செக் குடியரசு, கென்யா, 
மக்காவ், மாலத் தீவுகள், நமீபியா, நேபாளம், சிங்கப்பூர், தென் ஆப்பிரிக்கா, 
இலங்கை, சுவீடன்.
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9.5 வாய்ப்பாடுகளை உருவாக்குதல்
	 அட்டவணைத்தாளில் தரவுகளை உள்ளிட்ட 
பிறகு, வாய்பாடுகளைப் பயன்படுத்தி அதன் மீது 
கணக்கீடுகளைச் செய்யலாம். வாய்ப்பாடுகளை 
உருவாக்குவதற்கு, முதலில் அதன் கட்டளை 
அமைப்பை (Syntax) தெரிந்து க�ொள்ள வேண்டும். 
	 கால்க்–ல்  வாய்ப்பாடுகளை இரு 
முறைகளில் உள்ளீடலாம், நுண்ணறையில் 
நேரடியாக உள்ளிடலாம் (அ) வாய்பாடு பட்டையில் 
உள்ள உள்ளீடுத்தாரையில் உள்ளிடலாம். கால்க்–ல் 
உள்ளிடப்படும் வாய்ப்பாடுகள் = அல்லது + அல்லது 
- குறியுடன் த�ொடங்கி மதிப்புகள், செயற்குறிகள் 
மற்றும் நுண்ணறை முகவரிகளுடைய த�ொகுப்பாக 
அமையும்.
	 வாய்பாடுகள் = அல்லது + அல்லது 
– குறியீட்டுடன் த�ொடங்கலாம் எனினும், = 
(சமக்குறியுடன்) த�ொடங்குவது சிறந்த முறையாகும். 
இந்தப் பாடத்தில், அனைத்து வாய்பாடுகளும், 
செயற்கூறுகளும் = குறியுடன் தான் த�ொடங்கும். 
ஏதேனும் ஒரு வாய்ப்பாடு + அல்லது - குறியுடன் 
த�ொடங்கினால், அதன் த�ொடக்க மதிப்பு நேர்மறை 
அல்லது எதிர்மறை எண்ணாக கருதப்படும்.
9.5.1 செயற்குறிகள் (Operators):
	 கணித, புள்ளியியல் மற்றும் தருக்க 
செயல்பாடுகளைச் செய்வதற்கான குறியீடுகள் 
“செயற்குறிகள்” எனப்படும். மதிப்புகள், 
செயற்குறிகள் மற்றும் நுண்ணறை பார்வையிடல்கள் 
(நுண்ணறை முகவரி) ஆகியவற்றின் 
சேர்மானம் “க�ோவைகள்” (Expressions) 
என்று அழைக்கப்படுகின்றன. ஒபன் ஆஃபீஸ் 
கால்க் பல்வேறு வகையான செயற்குறிகளைக் 
க �ொ  ண் டு ள்ள  து . 
(1)	 எண்கணித செயற்குறிகள் (Arithmetic 
Operators)
(2)	 ஒப்பீட்டுச் செயற்குறிகள் (Relational 
Operators)
(3)	 பார்வையிடு செயற்குறிகள் (Reference 
Operators)
(4)	 உரை செயற்குறிகள் (Text Operators)
9.5.1.1 எண்கணித செயற்குறிகள்:
	 எளிய எண்கணித செயல்பாடுகளான 
கூட்டல், கழித்தல், பெருக்கல், வகுத்தல் 
ப�ோன்றவற்றை செய்வதற்கான குறியீடுகள் 
எண்கணித செயற்குறிகள் ஆகும். இந்த 
செயற்குறிகள் ஒரு எண் மதிப்பை விடையாக 
அ ளி க் கு ம் . 
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2 + கூட்டல் 98 25 = B2 + C2 123
3 - கழித்தல் 125 25 = B3 – C3 100
4 * பெருக்கல் 25 5 = B4 * C4 125
5 / வகுத்தல் 90 10 = B5 / C5 9
6 ^ அடுக்கு 25 2 = B6 ^ C6 625
7 % சதவீதம் 600 = B7 * 35% 72
8 சதவீதம் (%) செயற்குறி, க�ொடுக்கப்பட்ட 

தரவுக்கான விடையை சதவீதமாக தரும்.
அட்டவணை 9.1 எண்கணித செயற்குறிகள்

	 பயனர் நுண்ணறையில் ஒரு 

வாய்பாட்டைத் தட்டச்சு செய்து, Enter 

ப�ொத்தானை அழுத்திய பிறகு, நுண்ணறையில் 

கணக்கீட்டின் மதிப்பு த�ோன்றும். ஆனால்,  

வாய்பாட்டை பயனர் நுண்ணறையில் 

உண்மையில் தட்டச்சு செய்த வாய்பாட்டை 

மட்டுமே காட்டும். (படம் 9.15 காண்க)

உள்ளீடப்பட்ட வாய்பாடு

படம் 9.15 சதவீத செயற்குறி

9.5.1.2 ஒப்பீட்டுச் செயற்குறி

	 இரண்டு அல்லது அதற்கு மேற்பட்ட 

மதிப்புகள் சமமானதா, பெரியதா, சிறியதா  ப�ோன்ற 

தருக்க செயல்பாடுகளுக்காக மதிப்புகளை 

ஒப்பிட பயன்படும் செயற்குறிகள் ஒப்பீட்டு 

செயற்குறிகள் ஆகும். ஒப்பீடு என்ற ப�ொருள் 

தரும் விதமாக ஆங்கிலத்தில் Comparative 
Operator என்றழைக்கப்படும் இச்செயற்குறியை, 
Relational Operator என்றும் அழைக்கலாம். இந்த 

செயற்குறிகள் தருக்க மதிப்புகளான சரி (True) 
அல்லது தவறு (False) என்பதை விடையாகத் தரும்.
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2 > விடப் பெரியது 98 100 =B2>C2 FALSE

3 >=
விடப் பெரியது 

அல்லது சமம்
85 72 =B3>=C3 TRUE

4 < விட சிறியது 54 24 =B4<C4 FALSE

5 <=
விட சிறியது 

அல்லது சமம்
55 55 =B5<=C5 TRUE

6 = சமம் 12 12 =B6=C6 TRUE
7 <> சமமின்மை 54 45 =B7<>C7 TRUE

அட்டவணை 9.2 ஒப்பீட்டுச் செயற்குறிகள்

9.5.1.3 பார்வையிடு இயக்கி
	 நுண்ணறைகளின் பரப்பை குறிப்பிட 
பயன்படும் செயற்குறிகள் பார்வையிடு 
செயற்குறிகள் ஆகும். ஒரு நுண்ணறையிலிருந்து, 
மற்றொரு நுண்ணறை வரை த�ொடர்ச்சியாக உள்ள 
நுண்ணறைகளின் த�ொகுப்பே “பரப்பு” (Range) 
எனப்படும். கால்க்-ல் நுண்ணறைகளை குறிப்பிட 
மூன்று வகையான பார்வையிடு செயற்குறிகள் 
உள்ளது. அவையாவன, (1) பரப்பு பார்வையிடு 
செயற்குறி (Range Reference Operator) (2) பரப்பு 
இணைப்பு செயற்குறி (Range Concatenation) 
மற்றும் (3) குறுக்கீடு செயற்குறி (Intersection 
Operator).
(1) பரப்பு பார்வையிடு செயற்குறி:
	 அரைப்புள்ளி ( : ) பரப்பு பார்வையிடு 
செயற்குறி ஆகும். இது ஒரு குறிப்பிட்ட 

நுண்ணறைகளின் பரப்பை குறிக்கப் 
பயன்படுகிறது. இந்த செயற்குறியின் கட்டளை 
அமைப்பு பின்வருமாறு:
த�ொடக்க நுண்ணறை முகவரி (இடது பக்கம் ) :  

இறுதி நுண்ணறை முகவரி (வலது பக்கம்)
	 நேரியல் (Linear) பரப்பாக இருப்பின் 
த�ொடக்க நுண்ணறை முகவரியையும், இறுதி 
நுண்ணறை முகவரியையும் நேரடியாக குறிப்பிட 
வேண்டும். செவ்வக வடிவிலான பரப்பாக இருப்பின், 
த�ொடக்க நுண்ணறை முகவரி என்பது, செவ்வக 
பரப்பின், இடது மேல் ஓர (Upper left corner) 
நுண்ணறையின் முகவரியை குறிக்கும். இறுதி 
நுண்ணறை முகவரி என்பது, அப்பரப்பின் கீழ் 
வலது ஓர (Lower right corner) முகவரியை 
குறிக்கும்.

படம் 9.16  ஒப்பீட்டு செயற்குறிகளை உள்ளிடுதல்
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எடுத்துக்காட்டு:

(அ)	 ஒரு வரி பரப்பு: நுண்ணறைகள் A1, A2, A3, A4, A5 என்பது, A1:A5 என்று குறிப்பிடப்படும். 

(ஆ)	ச ெவ்வக வடிவிலான நுண்ணறைகளின் த�ொகுப்பு: நுண்ணறைகள் A2, A3, A4, ….. B2, B3, 
B4,….D5, D6 என்பன, A2:D6  என்று குறிப்பிடப்படும். A2:D6 என்பதும் ஒரு பரப்பு ஆகும். (படம் 
9.17-யை காண்க)

நுண்ணறைகளின் பரப்பு
தேர்ந்தெடுக்கப்பட்ட நெடுவரிசைகள் 

(உயர்த்திக்காட்டப்பட்டது) 
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படம் 9.17 தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளின் பரப்பு

	 மேற்காண் படத்தில் பெயர் பெட்டியில், தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளின் பரப்பு A2:D6 	
என உள்ளதை காணமுடியும்.
(2) பரப்பு இணைப்பு செயற்குறி

	 டில்டு ( ~ ) என்ற குறியீடு, பரப்பு இணைப்பு செயற்குறியாகும். இது இரண்டு வெவ்வேறு பரப்புகளை 
ஒன்றிணைத்து, கணக்கியல் செயல்பாடுகளை செய்யப் பயன்படுகிறது. இச்செயற்குறியின் கட்டளை 
அமைப்பு பின்வருமாறு:

இடது பரப்பு ~ வலது பரப்பு

reference left ~ reference right
எடுத்துக்காட்டு

	 நுண்ணறை A1 -லிருந்து A6 மற்றும் C3 -லிருந்து F3 வரையும் உள்ள மதிப்புகளின் கூட்டுத் 
த�ொகையை  காண =SUM(A1:A6 ~ C3:F3) என்ற வாய்ப்பாடு பயன்படுத்தப்பட்டுள்ளது.

	 ஒரு குறிப்பிட்ட பரப்பிலுள்ள மதிப்புகளின் கூட்டுத் த�ொகையை காண  SUM என்ற செயற்கூறு 
பயன்படுத்தப்படும். (படம் 9.18 காண்க)

செயற்படு கல முகவரி
(Address of the active cell)

இரண்டு பரப்புகளின் 
கூட்டுத்தொகை

(Sum of two set of values)

படம் 9.18 பார்வையிடு இணைப்பு செயற்குறி

குறிப்பு : SUM என்பது ஒரு குறிப்பிட்ட பரப்பிலுள்ள மதிப்புகளின் கூட்டுத் த�ொகையை கணக்கிடப் 
பயன்படுத்தப்படும் ஒரு செயற்கூற்று ஆகும். (படம் 9.18-யை காண்க) 
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குறுக்கீடு செயற்குறி:

	 இரண்டு பரப்புக் குழுக்களையும் 
இணைக்கும் செயற்குறி, குறுக்கீட்டு செயற்குறி 
ஆகும். இது பரப்பு இணைப்பு செயற்குறியை 
ஒத்தது. ஆச்சரிய குறி (!) குறுக்கீடு 
செயற்குறியாக பயன்படுத்தப்படுகிறது. இந்த 
செயற்குறியின் கட்டளை அமைப்பு பின்வருமாறு: 

இடது பரப்பு ! வலது பரப்பு

எடுத்துக்காட்டு:(A2:D3 ! B2:E4)

A

1

2

3

4

B C D E F

பரப்பு- 1 பரப்பு- 2A2 : D3

A1 B1 C1 D1 E1 F1

A2 B2 C2 D2 E2 F2

A3 B3 C3 D3 E3 F3

A4 B4 C4 D4 E4 F4

B2:D3பரப்பு 1 மற்றும் 2 ஆகியவற்றின் குறுக்கீடு

B2:E4

படம் 9.19 குறுக்கீடு செயற்குறி

(A2:D3!B2:E4) என்பதன் வெளியீடு, B2:D3. என்ற பரப்பிலுள்ள மதிப்புகளை ப�ொறுத்திருக்கும், ஏன்ெனன்றால் 
இந்த இரண்டு பரப்புகளும் A2:D3 மற்றும்  B2:E4 நுண்ணறையில்  உள்ளது. (படம் 9.19 மற்றும் 9.20 காண்க)

படம் 9.20 குறிக்கீட்டு செயற்குறியுடன் வேலை செய்தல்
9.5.1.4 உரை செயற்குறி:

	 ஒபன் ஆஃபீஸ் கால்க்-ல், "&" என்ற குறியீடு உரை செயற்குறியாகும். இரண்டு அல்லது 
அதற்கு மேற்பட்ட உரைகளை ஒன்றாக சேர்க்க இந்த செயற்குறி பயன்படுகிறது. இரண்டு உரைகளை 
ஒன்றாக சேர்த்தல் “உரை இணைத்தல்” (Text Concatenation) எனப்படும். உரை செயற்குறிக்கான 
கட்டளை அமைப்பு பின்வருமாறு: (படம் 9.21 காண்க) 
முதல் உரை உள்ள நுண்ணறை & இரண்டாம் உரை உள்ள நுண்ணறை

படம் 9.21 உரை செயற்குறி
	 எண்கணித செயற்குறிகளை வாய்பாடுகளில் பயன்படுத்தும் ப�ோது, ஒபன் ஆஃபீஸ் கால்க் ப�ொது 
கணக்கியல் க�ோட்பாட்டின் செயற்குறி முன்னுரிமை அடிப்படையில் கணக்கீடுகளைச் செய்யும். ப�ொதுக் 
கணக்கியல் செயற்குறி முன்னுரிமை வருமாறு:

i.	 அடுக்கு (Exponent  ^ )
ii.	 எதிர்நிலையாக்கம் (Negation - )
iii.	 பெருக்கல் மற்றும் வகுத்தல் (Multiplication and Division *, /)
iv.		  கூட்டல் மற்றும் கழித்தல் (Addition and Subtraction +, -)
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வாய்ப்பாட்டை உருவாக்குவதற்கான எடுத்துக்காட்டு:
எடுத்துக்காட்டு 1:
பின்வரும் தரவுகளை ஒரு அட்டவணைச் செயலியில் உள்ளீடு செய்க

Reg. No Name Tam Eng CS Com Acc
12001 Jayashree J 147 136 105 163 162
12002 Kowsalya T 156 148 149 147 179
12003 Muskan S 149 165 123 168 179
12004 Ashia Stephy R 168 144 146 192 167
12005 Vennila T P 199 198 150 200 200
12006 Deepika M 187 141 98 130 178
12007 Tharani J 165 102 100 192 192
12008 Thulasi A 143 169 88 176 173
12009 Ayisha B 120 138 109 182 167
12010 Jenifer A 145 135 95 180 185

	 அட்டவணைச்செயலியில் தரவுகள் தட்டச்சு செய்துமுடிக்கப்பட்ட பின், அட்டவணைத் தாள் 
கீழ்கண்டவாறு த�ோன்றும்.

 

உள்ளிடு செய்யப்பட்ட உரை நெடுவரிசையின் அகலத்தை விட அதிகமாக 
இருப்பின், நெடுவரிசையின் இறுதியில் சிவப்பு நிற முக்கோணம் த�ோன்றும் 

படம் 9.22 அட்டவணைச்செயலி எடுத்துக்காட்டு

9.5.2 வாய்பாட்டை உருவாக்குதல்:
	 ஒரு வாய்ப்பாட்டை உருவாக்கும்போது 
கீழ்காணும் விதிமுறைகளை கவனத்தில் க�ொள்ள 
வே  ண் டு ம் . 
•	 எந்த நுண்ணறையில் விடை வரவேண்டும�ோ, 

அந்த நுண்ணறையில் நுண்ணறை சுட்டி 
இருக்க வேண்டும். 

•	 வாய்ப்பாடுகள் அனைத்தும் = குறியுடன் 
த�ொடங்க வேண்டும். 

•	 ஒரு வாய்ப்பாடு உருவாக்கும் ப�ோது, ப�ொது 
கணக்கியல் விதியான BODMAS விதியை 
நினைவில் க�ொள்க. 

•	 ஒரு வாய்ப்பாட்டை உருவாக்குவதற்கான 
ப�ொது கட்டளை அமைப்பு:

= நுண்ணறை முகவரி1  <செயற்குறி> நுண்ணறை 
முகவரி 2 <செயற்குறி> ……………….
•	 நுண்ணறை முகவரி பார்வையிடல் இரண்டு 

வகை (i) ஒப்பீட்டு நுண்ணறை பார்வையிடல் 
(Relative cell reference) (ii) தனித்த 
நுண்ணறைப் பார்வையிடல் (Absolute Cell 
reference)

•	 ஒரு வாய்ப்பாட்டை உருவாக்கும்போது, ஒரு 
நுண்ணறையின் முகவரியை நேரடியாக 
பயன்படுத்துவது “ஒப்பீட்டு நுண்ணறை 
பார்வையிடல்” (Relative Cell reference) 
ஆ கு ம் .

•	 ஒப்பீட்டு நுண்ணறை பார்வையிடல் 
எ டு த் து க ்காட்   டு : 
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A1, B1, C1, D1 ஆகிய 
நுண்ணறைகளில் 
உள்ள மதிப்புகளின் 
கூட்டுத் த�ொகையை 
க ண க் கி ட .

=A1+B1+C1+D1

E4 லிருந்து H3 யை 
க ழி த ்த ல்

= H3 – E4

B5யுடன் A5யை 
பெ  ரு க ்க ல்

= A5 * B5

G1, G2, G3, G4 
ஆகியவற்றின் சராசரி

=(G1+G2+G3+G4)/4

•	 மேற்கண்ட அட்டவணையில் 
க�ொடுக்கப்பட்டுள்ள அனைத்து 
வாய்பாடுகளிலும், உள்ள நுண்ணறைகள் 
“ஒப்பீட்டு நுண்ணறை முகவரி” என்பதை 
நினைவில் க�ொள்க.

•	 வாய்பாடுகளை உருவாக்கும் ப�ோது, 
நுண்ணறை முகவரியின் நெடுவரிசையின் 
பெயர் மற்றும் வரிசை எண் ஆகியவற்றின் 
முன்னொட்டாக $ குறியீட்டை பயன்படுத்தும் 
ப�ோது, அந்த நுண்ணறைகள் ”தனித்த 
நுண்ணறை முகவரி”-களாக மாற்றம் 
பெறும்.

•	 தனித்த நுண்ணறை முகவரி எடுத்துக்காட்டு:

A1, B1, C1, 
D1 ஆகிய 

நுண்ணறைகளில் 

உள்ள 

மதிப்புகளின் 

கூட்டுத் 

த�ொகையை 

கணக்கிட.

=$A$1+$B$1+$C$1+$D$1

E4 லிருந்து H3 யை 

கழித்தல்
= $H$3 – $E$4

B5யுடன் A5யை 

பெ  ரு க ்க ல்
= $A$5 * B5

G1, G2, G3, G4 
ஆகியவற்றின் 

சராச    ரி

=($G$1+G2+$G$3+G4)/4

•	 ஒரு வாய்பாட்டில் உள்ள அனைத்து 
நுண்ணறை முகவரிகளும், தனித்த 
நுண்ணறைகளாகவ�ோ அல்லது ஒப்பீட்டு 
நுண்ணறைகளாகவ�ோ இருக்க வேண்டிய 

கட்டாயமில்லை. இரண்டு முகவரி 
முறைகளையும் கலந்தும் ஒரு வாய்பாடு 
உ ரு வ ா க ்கப்ப   ட ல ா ம் . 

•	 கீழே க�ொடுக்கப்பட்டுள்ள பகுதி ஒப்பீட்டு 
நுண்ணறை முகவரியின் பயன்பாட்டை 
விளக்குகின்றது. தனித்த நுண்ணறை பற்றி 
பின்பு படிக்கலாம்.

•	 H2 (நெடுவரிசைக்கு) நுண்ணறைக்கு 
சுட்டியை நகர்த்தவும்.

•	 கீழ்காணும் வாய்பட்டை தட்டச்சு செய்து, 
“Enter” ப�ொத்தானை அழுத்தவும்.

= C2+D2+E2+F2+G2 (படம் 9.25 காண்க)
	 இப்போது, நுண்ணறை C2, D2, E2, F2 
மற்றும் G2 ஆகியவற்றில் உள்ள மதிப்புகளின் 
கூட்டுத்தொகை நுண்ணறை H2-ல் த�ோன்றும்.
•	 மேலே உள்ள வாய்பாட்டின் மூலம், 

அட்டவணை செயலி நுண்ணறைகளுடன் 
எவ்வாறு செயலாற்றுகிறது என்பதை 
தெளிவாக அறிந்துக�ொள்ள முடியும்.

•	 ஒரு வாய்பாடு உருவாக்கப்படும் ப�ோது, 
நுண்ணறையில் உள்ள மதிப்பை நேரடியாக 
குறிப்பிடாமல், அந்த மதிப்பை உள்ளடக்கிய 
நுண்ணறையின் முகவரியை குறிப்பிடுவது 
மிகச்சிறந்த வழிமுறையாகும். அவ்வாறு 
ஒரு நுண்ணறையின் முகவரியை 
குறிப்பிடும்போது, அட்டவணைச் செயலி, 
அந்த நுண்ணறையில் உள்ள மதிப்பை 
கணக்கீட்டுக்கு எடுத்துக்கொள்கிறது. 
ஏதேனும் ஒரு சூழலில் நுண்ணறையில் 
உள்ள மதிப்பு மாறும் ப�ோது, அட்டவணை 
செயலி அதன் கணக்கீட்டு விடைகளை 
ம ாற்  றி க ் க ொ ள் ளு ம் . 

	 ம�ொத்த மதிப்பெண் கணக்கிடுவதற்கான 
வாய்பாடு உள்ளீடு செய்யப்பட்ட பின், 
அட்டவணை கீழ்கண்டவாறு த�ோன்றும். (படம் 
9.25 காண்க)

படம் 9.23 அட்டவணைத்தாளில் வாய்ப்பாட்டை 
உருவாக்குதல்

9.6 அட்டவணைத்தாளை சேமித்தல், 
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மூடுதல் மற்றும் மீண்டும் திறத்தல்
9.6.1 அட்டவணைத்தாளை சேமித்தல்:
	 ஒரு அட்டவணைத்தாளை சேமிக்கும் வழிமுறை, முந்தைய பாடத்தில் கற்ற ஒரு ஆவணத்தை 
சேமிக்கும் வழிமுறை ப�ோன்றதே. 
படிநிலை 1: 	 File→Save அல்லது Ctrl + S அல்லது செந்தரக் கருவிப்பட்டையிலுள்ள Save 
பணிக்குறியை கிளிக் செய்க.
படிநிலை 2:	 அட்டவணைச் செயலி முன்னர் சேமிக்கப்படவில்லை எனில், “Save As” உரையாடல் 
பெட்டி த�ோன்றும்.
படிநிலை 3: 	  “File Name” உரைப் பெட்டியில், அட்டவணைச் செயலிக்கு ஒரு பெயரை தட்டச்சு செய்யவும். 
ஒபன் ஆஃபீஸ் கால்க் அட்டவணைச் செயலி .ods என்ற நீட்டிப்புடன் (extension) சேமிக்கப்படும். 
படிநிலை 4:	 “Save” ப�ொத்தானை கிளிக் செய்யவும்.
“Save” ப�ொத்தானை கிளிக் செய்து அட்டவணைச் செயலி சேமிக்கப்பட்ட பின், அதன் பெயர் தலைப்புப் 
பட்டியில் த�ோன்றுவதை காணலாம். (படம் 9.24 காண்க).
குறிப்பு: சேமிக்கப்படும் ஒவ்வொரு க�ோப்பும், க�ொடாநிலையாக “Documents” என்ற க�ோப்புறைகளில் 
சேமிக்கப்படும்.

க�ோப்பு நீட்டிப்பு

	 கணிப்பொறி ஒரு க�ோப்பை எளிதில் அடையாளம் காண  நீட்டிப்பு பயன்படுகிறது. ப�ொதுவாக 

பயன்பாட்டில் உள்ள க�ோப்பு நீட்டிப்புகள் பின்வருமாறு:

பிரபலமான க�ோப்பு வகைகள் நீட்டிப்பு

உரைக் க�ோப்பு  (Text Files) .txt

மைக்ரோசாஃட் வேர்டு ஆவணம் (Microsoft 
Word Documents)

.doc / .docx 

ஒபன் ஆஃபிஸ் ஆவணம் (OpenOffice 
Documents)

.odt

மைக்ரோசாஃட் எக்ஸெல் (Microsoft Excel) .xls / .xlsx
ஒபன் ஆஃபிஸ் கால்க் (OpenOffice Calc) .ods
மைக்ரோசாஃட் பவர்பாய்ண்ட் (Microsoft 
PowerPoint)

.ppt / .pptx

ஒபன் ஆஃபீஸ் இம்ப்ரெஸ் (OpenOffice 
Impress)

.odp

இயங்கு க�ோப்புகள்/ பயன்பாடுகள் 
(Executable Files / Applications)

 .exe

இணைய பக்கங்கள் (Web Pages) .htm / .html
ப�ோர்ட்டபல் டாக்குமெண்ட் ஃபார்மெட் 
(Portable Document Format)

.pdf

டிஜிட்டல் புகைப்படங்கள் (Photos)
.jpg / .jpeg (Joint Photographic Experts 
Group)

அசைவுப்படங்கள் (Animated Images) .gif (Graphical Image Format)

ஒலிக் க�ோப்புகள் (Audio) .mp3

ஒலி / ஒளிக் க�ோப்புகள் (Audio / Video) .mp4
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க�ோப்பின் பெயர் பயன்பாட்டின் பெயர்

படம் 9.24  சேமிக்கப்பட்ட அட்டவணைச்செயலி

சேமிக்கப்பட்ட க�ோப்பு தானாகவே "Document folder" -ல் இருத்தப்படும்.

குறிப்பு

உங்களுக்குத் தெரியுமா?

சேமித்தல் என்றால் என்ன?

முதன்மை நினைவகத்திலுள்ள தகவல்களை, வன்வட்டு, பென் டிரைவ், மெமரி 

சிப் ப�ோன்ற இரண்டாம் நிலை நினைவகத்திற்கு மாற்றம் செய்யும் செயல்நுட்பம் 

சேமித்தல் எனப்படும். 

9.6.2 தானியங்கு சேமித்தல் (Auto Save)
	 ஓபன் ஆஃபீஸ் ஒரு க�ோப்பை, குறிப்பிட்ட கால இடைவெளியில் சேமிக்கும் வசதியை 
க�ொண்டுள்ளது, இது தானியங்கு சேமித்தல் என்று அழைக்கப்படுகிறது. க�ொடாநிலை தானியங்கு 
சேமிப்புக்கான கால இடைவெளி 15 நிமிடங்களாகும். இந்த கால இடைவெளியை மேலும் குறைக்க 
முடியும். எதிர்பாரா விதமாக கணிப்பொறியின் இயக்கம் தடைபடும் ப�ோது, இந்த வசதி க�ோப்புகளை 
அழிவிலிருந்து காக்கின்றது. 
9.6.3 அட்டவணைத்தாளை மூடுதல்:
	 ஒரு அட்டவணைத் தாள் சேமிக்கப்பட்டாலும், அது திறந்தே இருக்கும். எனவே, அதில் த�ொடர்ந்து 
வேலை செய்யலாம். வேலை முடிவுற்றதும், File→Save அல்லது Ctrl + S அல்லது Save பணிக்குறியை 
கிளிக் செய்து, சேமித்த பின்னர் File→Close அல்லது Ctrl + W பயன்படுத்தி அட்டவணைத்தாளை 
முறையாக மூட வேண்டும்.
9.6.4 ஏற்கனவே உள்ள அட்டவணைத்தாளை திறத்தல்:
9.6.4.1 Open உரையாடல் பெட்டியை பயன்படுத்துவது
	 ஏற்கனவே உருவாக்கப்பட்ட ஒரு அட்டவணைத்தாளை மீண்டும் திறப்பதற்கு File → Open 
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கட்டளை அல்லது Open பணிக்குறி அல்லது Ctrl + O ஆகிய ஏதேனும் ஒன்றை பயன்படுத்தலாம். 
அவ்வாறு செய்யும் ப�ோது, படம் 9.25ல் காட்டப்பட்டுள்ளவாறு Open உரையாடல் பெட்டி த�ோன்றும். இது 
Save As உரையாடல் பெட்டியை ப�ோன்றே இருக்கும். 
	 இந்த உரையாடல் பெட்டியிலிருந்து, திறக்கப்பட வேண்டிய க�ோப்பை பட்டியலிலிருந்தோ அல்லது 
எந்த க�ோப்புறையில் அந்த அட்டவணைத்தாள் சேமிக்கப்பட்டுள்ளத�ோ அங்கிருந்து அதனை தேர்வு 
செய்து திறக்க வேண்டும். 

தானமைவு க�ோப்புறை

க�ோப்புகள் மற்றும் 
க�ோப்புறைகள்

Read only 
தேர்வுகள்

படம் 9.25 Open உரையாடல் பெட்டி

9.6.4.2 Recent Document தேர்வை பயன்படுத்துவது

	 ஒபன் ஆஃபீஸ் சமீபமாக திறக்கப்பட்ட க�ோப்புகளின் விவரங்களை பதிவு செய்துவைக்கும். இந்த 
வசதியைப் பயன்படுத்தியும், ஏற்கனவே உள்ள அட்டவணைத்தாளை திறக்க முடியும். இவ்வசதி மூலம் 
ஒரு க�ோப்பை திறக்க, File→Recent Document என்ற தேர்வை கிளிக் செய்ய வேண்டும். படம் 9.26ல் 
காட்டப்பட்டுள்ளபடி சமீபத்தில் திறக்கப்பட்ட க�ோப்புகளின் பட்டியல் த�ோன்றும். 

சமீபத்தில் திறக்கப்பட்ட 
ஆவணங்கள்

படம் 9.26 சமீபத்தில் திறக்கப்பட்ட ஆவணங்களின் பட்டியல்

9.7 நகலெடுத்தல், வெட்டுதல் மற்றும் ஒட்டுதல்
9.7.1 தரவை நகலெடுத்து ஒட்டுதல்:
•	 நகலெடுக்க வேண்டிய நுண்ணறைகளை தேர்வு செய்க.
•	 Edit → Copy அல்லது செந்தர கருவிப்பட்டையில் உள்ள “Copy” பணிக்குறியை கிளிக் செய்க 

அல்லது விசைப்பலகையில் Ctrl+C சாவி சேர்மானத்தை அழுத்துக.
•	 நகலெடுக்கப்பட்டவை எந்த நுண்ணறையில் ஒட்டப்பட வேண்டும�ோ, அந்த நுண்ணறைக்கு 

நுண்ணறை சுட்டியை நகர்த்தவும்.
•	 Edit → Paste அல்லது கருவிப்பட்டையில் உள்ள “Paste” பணிக்குறியை கிளிக் செய்யவும். அல்லது 

விசைப்பலகையில் Ctrl+V சாவி சேர்மானத்தை அழுத்தவும்.
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9.7.2 தரவை வெட்டி ஒட்டுதல்:
•	 வெட்டப்பட வேண்டிய நுண்ணறைகளை தேர்வு செய்க.
•	 Edit → Cut அல்லது செந்தர கருவிப்பட்டையில் உள்ள “Cut” பணிக்குறியை கிளிக் செய்க அல்லது 

விசைப்பலகையில் Ctrl+X சாவி சேர்மானத்தை அழுத்துக.
•	 வெட்டப்பட்டவை எந்த நுண்ணறையில் ஒட்டப்பட வேண்டும�ோ, அந்த நுண்ணறைக்கு நுண்ணறை 

சுட்டியை நகர்த்தவும்.
•	 Edit → Paste அல்லது கருவிப்பட்டையில் உள்ள “Paste” பணிக்குறியை கிளிக் செய்யவும். அல்லது 

விசைப்பலகையில் Ctrl+V சாவி சேர்மானத்தை அழுத்தவும்.
9.7.3 வாய்ப்பாட்டை நகலெடுத்து ஒட்டுதல்:
•	 ஒரு தரவை நகலெடுத்து ஒட்டுவதற்கு என்னென்ன வழிமுறைகள் பின்பற்றப்பட்டத�ோ, அதே 

வழிமுறை தான், ஒரு வாய்ப்பாட்டை நகலெடுத்து ஒட்டுவதற்கும் பின்பற்றப்பட வேண்டும். 
	 ஒரு வாய்ப்பாட்டை ஒரு நுண்ணறையிலிருந்து மற்றொரு நுண்ணறையில் நகலெடுத்து 
ஒட்டும்போது, நகலெடுக்கப்பட்ட வாய்பாட்டின் நுண்ணறை முகவரி, ஒட்டப்பட்ட நுண்ணறையின் 
முகவரியாக மாற்றம் பெறும். இதற்கு “ஒப்பீட்டு நுண்ணறை பார்வையிடல்” என்று பெயர். (படம் 9.27  
காண்க.) எடுத்துக்காட்டு:

நுண்ணறை D2ல் ஒட்டப்படும் ப�ோது = B3* C3 என மாற்றம்பெறும்

நுண்ணறை D2ல் தட்டச்சு செய்யப்பட்ட வாய்ப்பாடு = B2*C2

வரிசை எண்

படம் 9.27 வாய்ப்பாட்டை நகலெடுத்து ஒட்டுதல்

9.7.4 ஒரு நுண்ணறையில் நகலெடுத்து, ஒன்றுக்கும் மேற்பட்ட நுண்ணறைகளில் ஒட்டுதல்:
(எடுத்துக்காட்டு 1க்கு படம் 9.23 காண்க.)
படிநிலை 1:	 விசைப்பலகையில் Ctrl + C சாவி சேர்மானத்தை அழுத்திய�ோ அல்லது பட்டிப் பட்டையில் 
Edit → Copy என்ற கட்டளையைக் கிளிக் செய்தோ அல்லது செந்தர கருவிப்பட்டையில் (standard) 
Copy பணிக்குறியைக்  கிளிக் செய்தோ, நுண்ணறை H2-ல் உள்ள வாய்பாட்டை நகலெடுக்கவும்.

 

படம் 9.28 நுண்ணறையில் நகலெடுத்து, ஒன்றுக்கு மேற்பட்ட நுண்ணறை ஒட்டுதல் 

Chapter 9.indd   157 20-04-2020   15:59:23



158

படிநிலை 2:	ம�ொ த்த மதிப்பெண் கணக்கிடப்பட வேண்டிய, H3 முதல் H11 வரையுள்ள நுண்ணறை 
பரப்பைத் தேர்வு செய்க.
படிநிலை 3:	 Ctrl + V அல்லது Edit →Paste அல்லது Paste பணிக்குறி, இவற்றில் ஏதேனும் ஒன்றை 
பயன்படுத்தி, நுண்ணறை H2-ல், நகலெடுக்கப்பட்ட வாய்ப்பாட்டை ஒட்டவும். 

1.	 எடுத்துக்காட்டு 1ல் உருவாக்கப்பட்ட அட்டவணைச்செயலியைத் திறந்துக�ொள்ளவும்.
2.	நெ டுவரிசை I1ல் “Average” என்ற புதிதாக ஒரு நெடுவரிசை தலைப்பைச் சேர்க்கவும்.
3.	 I2 ல் மதிப்பெண்களின் சராசரியைக் கணக்கிட வாய்பாடு ஒன்றை உருவாக்கவும்.
4.	 I2ல் உருவாக்கப்பட்ட வாய்பாட்டை மற்ற அனைத்து நுண்ணறைகளுக்கும் நகலெடுத்து 

ஒட்டுக. 
5.	 மாற்றங்களைச் சேமித்து, க�ோப்பை மூடவும். 

செய்முறை பயிற்சி:

9.8 தானியங்கு நிரப்பு வசதி: 
	 இதுவரை ஒரு நுண்ணறையிலிருந்து, மற்றொரு நுண்ணறைக்கு எவ்வாறு நகலெடுத்து ஒட்டுவது 
என்பதைப் பற்றி அறிந்துக�ொண்டீர்கள். ஒரு நுண்ணறையிலுள்ள தரவுகளையும், வாய்பாடுகளையும் 
நகலெடுத்து, மற்ற நுண்ணறைகளைத் தேர்வு செய்து அதில் ஒட்டுவதற்கு மாற்றாக, தானியங்கு நிரப்பு 
வசதி (Auto Fill feature) பயன்படுகிறது.  
	தா னியங்கு நிரப்பு வசதியின் மூலம், ஒரு நுண்ணறையில் உள்ள தரவுகள் அல்லது வாய்பாடுகளை, 
மற்ற நுண்ணறைகளில் நிரப்ப, வாய்பாடு உள்ளிடப்பட்ட நுண்ணறையில் நுண்ணறைச் சுட்டியை இருத்தி, 
அதன் “Drag fill handle” என்றழைக்கப்படும் பகுதியை மற்ற நுண்ணறைகளின் மீது மேலிருந்து 
கீழாகவ�ோ அல்லது இடமிருந்து வலமாகவ�ோ இழுக்க வேண்டும். 

இழுத்து நிரப்புதல் புள்ளி
 (Drag Fill Handle)

படம் 9.29 இழுத்து நிரப்புதல் புள்ளி

	 அவ்வாறு செய்யும் ப�ோது, இழுக்கப்படும் வாய்பாடு, ஒப்பீட்டு நுண்ணறை முகவரியை 
க�ொண்டிருப்பின், முன்னர் விவரிக்கப்பட்டது ப�ோல, வாய்பாடு, அனைத்து நுண்ணறைகளிலும் அந்தந்த 
வரிசைகளுக்கு ஏற்ப வாய்பாட்டின் நுண்ணறை முகவரியும் மாறிவிடும். 
	 நுண்ணறைகளின் மீது கிளிக் செய்து இழுப்பதற்கு பதிலாக, நுண்ணறைகளைத் தேர்ந்தெடுத்து 
Edit → Fill  →Down அல்லது Edit → Fill → Right பயன்படுத்தலாம்.

9.8.1 தானியங்கு எண் வரிசை நிரப்பி (Auto Fill Series)
	 தானியங்கு நிரப்பு வசதி எண் வரிசைகளை உருவாக்கவும் பயன்படுகிறது. எடுத்துக்காட்டாக, 
1,2,3 ……. என எண் வரிசையை உருவாக்க, நுண்ணறைச் சுட்டியின் Drag fill handle-யை இழுத்தாலே 
ப�ோதும். 
	 முழு எண் வரிசையை உருவாக்குதல்:
படிநிலை 1:	 நுண்ணறை A1ல் 1 என தட்டச்சு செய்து Enter ப�ொத்தானை அழுத்துக.
படிநிலை 2:	 மீண்டும் நுண்ணறை சுட்டியை A1க்கு நகர்த்தவும்.
படிநிலை 3:	 நுண்ணறை சுட்டியின் Drag fill handle –லின் மீது சுட்டி அம்புக்குறியை வைக்க 

வேண்டும். இப்போது சிறிய + குறி த�ோன்றும்.
படிநிலை 4:	 இப்போது, நுண்ணறை சுட்டியின் Drag fill handle-யை கீழ்நோக்கி இழுக்க வேண்டும். 

அவ்வாறு செய்யும்போது ஒவ்வொரு நுண்ணறையிலும் நிரப்பப்படும் மதிப்பு நுண்ணறை சுட்டியின் 
வலது பக்கத்தில் படம் 9.29 ல் உள்ளவாறு த�ோன்றும்.
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படிநிலை 5:	தேவை யான எண் வரிசை த�ோன்றிய பின், சுட்டியை இழுப்பதை விட்டுவிடவும். 

இழுத்து 
நிரப்புதல் புள்ளி 

இழுக்கப்பட்ட 
நுண்ணறைகள்

உருவாக்கப்பட்ட எண் வரிசை

படம் 9.30 தானியங்கு எண்வரிசை நிரப்பி

9.8.2 Edit → Fill → Series கட்டளையை பயன்படுத்தி எண் வரிசையை உருவாக்குதல்:
	 Edit → Fill → Series கட்டளை, பல்வேறு எண் வரிசைகளை உருவாக்க பயன்படுகிறது. இந்த 
வசதியை பயன்படுத்துவதற்கு முன் தேவையான நுண்ணறைகள் தேர்வு செய்யப்பட வேண்டும். இந்த 
முறையில், கீழிருந்து மேலாக, மேலிருந்து கீழாக, வலமிருந்து இடமாக, இடமிருந்து வலமாக என எல்லா 
திசைகளிலும் எண் வரிசைகளை உருவாக்க முடியும். (படம் 9.31 காண்க)

Direction:	 Down / Right/Up / Left என்ற நுண்ணறைத் தேர்வின் திசையை தேர்வு செய்ய வேண்டும்.

Series type : 
Linear: 	கூட்டுத்தொகை த�ொடர்களை உருவாக்க இந்த தேர்வை கிளிக் செய்ய வேண்டும். 

(எடுத்துக்காட்டாக: 2, 4, 6, 8, 10,……….)
Growth: 	பெ ருக்கல் த�ொகை த�ொடர்களை உருவாக்க இந்த தேர்வை கிளிக் செய்ய வேண்டும். 
(எடுத்துக்காட்டாக: 2, 4, 8, 16, 32, 64 ……….)
Date:	தே தித் த�ொடர்களை உருவாக்க இதனை தேர்வு செய்ய வேண்டும். இந்த தேர்வை தேர்வு 
செய்தவுடன், Time unit என்ற பிரிவு தரவு உள்ளீட்டு நிலைக்கு மாறும் (Enabled).
AutoFill:	த�ொ டர்ச்சியான எண் மதிப்புகளை உருவாக்க இந்த தேர்வை தேர்வு செய்ய வேண்டும். 
இந்த தேர்வை தேர்ந்தெடுத்தவுடன், Time unit, End value மற்றும் Increment ப�ோன்ற பிரிவுகள் தரவு 
உள்ளிட முடியாத நிலைக்கு மாற்றம் பெறும் (Disabled).
Time Unit: Date தேர்வை தேர்ந்தெடுக்கும் ப�ோது மட்டுமே இந்த பிரிவு உள்ளீட்டு நிலைக்கு மாறும்.

Day		  :	நா ள் வாரியான தேதித் த�ொடர்களை உருவாக்க

Weekday		  :	 வார இறுதியை மையமாகக் க�ொண்ட த�ொடர்களை உருவாக்க.

Month		 : 	 மாத வாரியான தேதித் த�ொடர்களை உருவாக்க

Year		  :	 ஆண்டுவாரியான தேதித் த�ொடர்களை உருவாக்க

Start Value: 
•	 உருவாக்கப்பட வேண்டிய த�ொடரின் த�ொடக்க மதிப்பு

End Value:
•	 த�ொடரின் இறுதி மதிப்பு

•	 இறுதி மதிப்பை உள்ளிடவில்லை எனில், தேர்வு செய்யப்பட்ட நுண்ணறைகளின் பரப்பின் கடைசி 
நுண்ணறை வரை த�ொடர் உருவாக்கப்படும்.
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படம் 9.31  Fill series உரையாடல் பெட்டி
•	 க�ொடுக்கப்படும் இறுதி மதிப்பை விட குறைவான எண்ணிக்கையிலான நுண்ணறைகள் தேர்வு 

செய்யப்பட்டிருப்பின், தேர்வு செய்யப்பட்ட நுண்ணறைகளில் மட்டுமே த�ொடர் உருவாகும்.
Increment:
•	 ஒரு த�ொடரின் முதலாவது மதிப்பிற்கும், இரண்டாம் மதிப்பிற்கும் இடையே உள்ள வேறுபடும் 

மதிப்பு Increment எனப்படும். அத்தொடரின் மூன்றாவது மதிப்பு, இந்த முதல் இரண்டு மதிப்புகளின் 
வித்தியாச மதிப்பின் அடிப்படையிலேயே உருவாகும்.

இறங்குவரிசை எண் த�ொடர்களை உருவாக்க, Increment மதிப்பை எதிர்மறை எண்ணாக வழங்க 
வேண்டும். 

(அ) 2 முதல் 20 வரையான எண்களில் உள்ள 
இரட்டைப்படை எண்களின் த�ொடர் 
ஒன்றை உருவாக்குக.

(ஆ) 5, 10, 15, 20 ……. எனத் 
தேர்ந்தெடுக்கப்பட்டுள்ள 
நுண்ணறைகளின் அளவுக்கு 
த�ொடர் மதிப்புகளை உருவாக்குக.

(இ) 2, 4, 8, 16 ……… 2048 வரையான எண் 
த�ொடர் உருவாக்குக.

(ஈ) 33, 30, 27 ……….. 3 வரையான எண் 
த�ொடர் உருவாக்குக.

(உ) இன்று வெள்ளிக்கிழமை என்று 
கற்பனை செய்து, இன்றைய 
தேதியை உள்ளிட்டு, அடுத்த 25 
வெள்ளிக்கிழமைகளின் தேதிகளை 
க ண்ட  றி க .

செய்முறை பயிற்சி:

9.8.3 தேதிக் கணக்கீடு

	 கைவழி தேதிக் கணக்கீடு மிகவும் சிக்கலான ஒரு செயலாகும். ஏனெனில், ஒவ்வொரு மாதத்திற்கும் 
எத்தனை நாட்கள் என்பதை நினைவில் க�ொள்ள வேண்டும். அட்டவணை செயலியில் தேதிக்கணக்கீடு 
மிகவும், எளிய ஒரு செயல்முறையாகும். அட்டவணைச் செயலியில், ஒரு தேதியுடன், ஒரு எண்ணைக் 
கூட்டி, புதிய ஒரு தேதியை உருவாக்க முடியும். அதே ப�ோல இரண்டு தேதிக்கு இடையே உள்ள ம�ொத்த 
நாட்களின் எண்ணிக்கையை காணமுடியும். மேலும், பல்வேறு தேதி கணக்கீட்டு செயற்கூறுகளும் 
அட்டவணை செயலில் உள்ளது.

	 எடுத்துக்கட்டாக, A2 என்ற நுண்ணறையில் 02/06/2018 என்று உள்ளிடவும். உள்ளிடப்பட்ட இந்த 
தேதியிலிருந்து 80 நாட்களுக்கு பிறகு என்ன தேதி என்பதை கண்டறிய, =A2 + 80 என்ற வாய்பாட்டை 
A4 நுண்ணறையில் பயன்படுத்தினால், 05/17/18 என்று விடை வரும்.
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தேதி 05/17/18 நுண்ணறையில் த�ோன்றும்.

நீவீர் பிறந்து எத்தனை நாட்கள் 
ஆனது? கண்டுபிடி
•	 முதல் நுண்ணறையில் 
இன்றைய தேதியை உள்ளீடு 

ச ெ ய ்ய வு ம் .

•	 இரண்டாவது நுண்ணறையில், உமது 
பிறந்த தேதியை உள்ளீடு செய்யவும்.

•	 மூன்றாவது நுண்ணறையில், பின்வருமாறு 
வாய்பாட்டை உருவாக்கவும்.

•	 மூன்றாவது நுண்ணறை = முதல் 
நுண்ணறை – இரண்டாவது நுண்ணறை.

அட்டவணைத்தாளை பதிப்பாய்வு செய்தல் 
மற்றும் வடிவூட்டல்

9.9 நெடுவரிசைகள், வரிசைகள் மற்றும் 
நுண்ணறைகளை சேர்த்தல்:

	 கால்க்-ல் அட்டவணைத்தாளில், 
நெடுவரிசைகள், வரிசைகள் மற்றும் 

நுண்ணறைகளை ம�ொத்தமாகவ�ோ அல்லது 
ஒன்றுக்கு மேற்பட்டதாகவ�ோ சேர்க்க முடியும். 
9.9.1 நெடுவரிசைகளைச் சேர்த்தல்:

	 ஒரு புதிய நெடுவரிசையைச் 
சேர்க்கும் ப�ோது, சேர்க்கப்படும் நெடுவரிசை 
நடப்பு நெடுவரிசைக்கு இடது பக்கத்தில் 
சேர்க்கப்படும். நடப்பு நெடுவரிசை என்பது, எந்த 
நெடுவரிசையில், நுண்ணறைச் சுட்டி உள்ளத�ோ, 
அந்த நெடுவரிசையைக் குறிக்கும். கால்க்-ல் 
அட்டவணைத்தாளில், எங்கு வேண்டுமானாலும் 
ஒரு புதிய நெடுவரிசையைச் சேர்க்க முடியும்.

நெடுவரிசையைச் சேர்க்கும் வழிமுறைகள்:

படிநிலை 1:	 எந்த நெடுவரிசையில் ஒரு புதிய 
நெடுவரிசை சேர்க்கப்பட வேண்டும�ோ, அந்த 
நெடுவரிசையின் பெயரின் மீது கிளிக் செய்து, 
அதனை தேர்ந்தெடுத்துக்கொள்ளவும்.

படிநிலை 2: தேர்ந்தெடுக்கப்பட்ட நெடுவரிசையின் 
பெயரில், சுட்டியை வைத்து, வலது கிளிக் 
செய்யவும். இப்போது ஒரு மேல்மீட்பு பட்டிப் 
பட்டைத் த�ோன்றும்.

படிநிலை 3: த�ோன்றும் மேல்மீட்பு பட்டிப் 
பட்டையிலிருந்து, “Insert Columns” என்ற 
கட்டளையைத் தேர்வு செய்யவும்.

இப்போது, ஒரு புதிய நெடுவரிசை நடப்பு 
நெடுவரிசைக்கு இடது பக்கத்தில் 
சே  ர ்க்கப்பட்     டி ரு க் கு ம் .

1  இங்கே வலது கிளிக் செய்யவும்

3  நெடுவரிசையை சேர்க்க கிளிக் செய்யவும்

2  மேல் மீட்பு பட்டி த�ோன்றும்

படம் 9.32 நெடுவரிசையைச் சேர்த்தல் – மேல்மீட்பு பட்டிப் பட்டை

	 Insert → Columns கட்டளையைப் பயன்படுத்தியும், ஒரு புதிய நெடுவரிசையைச் சேர்க்க முடியும். 
(படம் 9.32 காண்க )
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"Insert" பட்டியை கிளிக் செய்க

"columns" தேர்வை கிளிக் செய்க

படம் 9.33 Insert பட்டிப் பட்டை பயன்படுத்தி 
நெடுவரிசையை சேர்த்தல்

(1)	 எடுத்துக்காட்டு 1-ல் உருவாக்கப்பட்ட 
அட்டவணைச்செயலியைத் 
தி றந்  து க �ொள்ள    வு ம் .

(2)	நெ டுவரிசை Eக்கும் Fக்கும் இடையே ஒரு 
புதிய நெடுவரிசையை சேர்க்கவும்.

(3)	 புதிதாக சேர்க்கப்பட்ட நெடுவரிசையில் 
“Eco” என்று தலைப்பிடவும். பின்னர், 
அனைத்து மாணவர்களுக்கும் 
ப�ொருளியல் பாடத்திற்கான 
மதிப்பெண்களை உள்ளிடவும்.

(4)	 “Name” மற்றும் “Tamil” 
நெடுவரிசைகளுக்கு இடையே மேலும், 
ஒரு புதிய நெடுவரிசையைச் சேர்க்கவும். 

(5)	 புதிதாக சேர்க்கப்பட்ட அந்த 
நெடுவரிசைக்கு “Date of Birth” என்று 
தலைப்பிட்டு, அனைத்து மாணவர்களின் 
பிறந்த தேதியை உள்ளிடவும்.

(6)	 அட்டவணைச்செயலியை சேமித்து 
மூ ட வு ம் .

செய்முறை பயிற்சி:

9.9.2 வரிசையைச் சேர்த்தல்: 

	 அட்டவணைத்தாளில், ஒரு புதிய 
வரிசையைச் சேர்க்கும் ப�ோது, சேர்க்கப்படும் 
புதிய வரிசை நடப்பு வரிசைக்கு மேல்பக்கமாக 
சேர்க்கப்படும். நடப்பு வரிசை என்பது, எந்த வரிசையில் 
நுண்ணறை சுட்டி உள்ளத�ோ, அந்த வரிசையைக் 
குறிக்கும். கால்க்-ல் ஒரு புதிய வரிசையை எங்கு 
வேண்டுமானாலும் செருக முடியும்.
ஒரு வரிசையைச் சேர்ப்பதற்கான வழிமுறைகள்:
	 படிநிலை 1:	 எந்த வரிசைக்கு மேல் 

ஒரு புதிய வரிசை சேர்க்கப்பட வேண்டும�ோ, 
அந்த வரிசை எண்ணை கிளிக் செய்து, அந்த 
வரிசையைத் தேர்ந்தெடுத்துக்கொள்ளவும்.

	 படிநிலை 2:	தே ர்ந்தெடுக்கப்பட்ட 
வரிசை எண் மீது, சுட்டியில் வலது கிளிக் 
செய்யவும். இப்போது, ஒரு மேல்மீட்பு பட்டிப் 
பட்டைத் த�ோன்றும்.

	 படிநிலை 3:	மே ல்மீட்பு பட்டிப் 
பட்டையில், “Insert Rows” கட்டளையை 
தேர்வு செய்யவும்.

	 இப்போது, ஒரு புதிய வரிசை தேர்வு 
செய்யப்பட்ட வரிசைக்கு மேல் பக்கத்தில் 
சே  ர ்க்கப்ப    டு ம் .

வரிசையை தேர்ந்தெடுக்கவும், மேல்மீட்பு பட்டியை பெறுவதற்கும் இங்கே வலது கிளிக் செய்யவும்

"Insert Rows" கிளிக் செய்யவும்

படம் 9.34 வரிசையைச் சேர்த்தல் – மேல்மீட்பு 
பட்டி

	 Insert → Rows கட்டளையைப் 
பயன்படுத்தியும் ஒரு புதிய வரிசையை 
சேர்க்க முடியும். (படம் 9.35யை காண்க)

"Insert" பட்டியை கிளிக் செய்யவும்

தேர்ந்தெடுக்கப்பட்ட  
வரிசைக்கு மேல் ஒரு 

புதிய வரிசை 
சேர்க்கப்படும்

"Rows" தேர்வை கிளிக் செய்க 

படம் 9.35 வரிசையைச் சேர்த்தல் – பட்டிப் பட்டை
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(1)	 எடுத்துக்காட்டு -1ல் உருவாக்கப்பட்ட அட்டவணைத்தாளை திறக்கவும்.

(2)	 ஒவ்வொன்றாக எட்டு வரிசைகளை சேர்த்து, கீழ்காணும் அட்டவணையில் தரவுகளை 

உள்ளீடு செய்யவும்.

(3).	 பின்னர் சேமித்து மூடவும்.
Reg. No Name Date of Birth Tam Eng CS Eco Com Acc
12101 Sarika S 26/05/2001 145 135 145 125 180 196
12102 Jewees Celcya J 11/04/2001 102 165 134 95 180 134
12103 Yuvarani T 27/06/1999 172 130 107 155 162 130
12104 Meharunisha I 30/05/2001 132 146 112 185 192 176
12105 Priya W 07/03/2000 130 172 100 92 162 155
12106 Vijaya Vasavi K 03/06/2001 198 175 149 148 158 135
12107 Deepika B 14/03/2001 120 182 103 144 107 186
12108 Viji V 19/04/2001 137 173 128 148 125 177

செய்முறை பயிற்சி:

9.9.3 நுண்ணறைகளைச் சேர்த்தல்:
•	 ஏற்கனவே உள்ள நுண்ணறைகளுக்கு 

இடையே ஒரு புதிய நுண்ணறையைச் 
சேர்க்க, நுண்ணறையின் மேல் வலது கிளிக் 
செய்யவும். 

•	 இப்போது த�ோன்றும் மேல்மீட்பு 
பட்டியிலிருந்து “Insert Cells” கட்டளையை 
கிளிக் செய்யவும். 

•	 இப்போது “Insert Cells” உரையாடல் 
பெட்டி, கீழ்காணும் நான்கு விருப்பத் 
தேர்வுகளுடன் த�ோன்றும். 

(1) Shift cells down	 (2) Shift cells right  (3) 
Entire row	 (4) Entire Column
இந்த நான்கு விருப்பத் தேர்வுகளில், ஏதேனும் 
ஒன்றை தேர்ந்தெடுக்கவும்.

(1)	 Shift cells down – தற்போது 
நுண்ணறை எங்கு உள்ளத�ோ, அங்கு புதிய 
நுண்ணறை செருகப்படும். ஏற்கனவே உள்ள 
நுண்ணறைகள் கீழ்பக்கமாக நகர்ந்துவிடும்.

(2)	 Shift cells right -  தற்போது நுண்ணறை 
எங்கு உள்ளத�ோ, அங்கு புதிய நுண்ணறை 
செருகப்படும். ஏற்கனவே உள்ள நுண்ணறைகள் 
வலது பக்கமாக நகர்ந்துவிடும்.

(3) Entire row – ஒரு புதிய வரிசையை சேர்க்க.

(4) Entire Column – ஒரு புதிய நெடுவரிசையை 
சேர்க்க

படம் 9.36 நுண்ணறைகளை சேர்த்தல் 
உரையாடல் பெட்டி

9.9.4 ஒன்றுக்கும் மேற்பட்ட வரிசை அல்லது 
நெடுவரிசைகளை சேர்த்தல்:

	 ஒவ்வொரு வரிசை அல்லது நெடுவரிசையாக 
சேர்ப்பதற்கு பதிலாக, ஒன்றுக்கும் 
மேற்பட்ட வரிசை அல்லது நெடுவரிசைகளை 
ஒரே நேரத்தில் சேர்க்க முடியும்.

•	 செருகப்படுவதற்காக ஒன்றுக்கும் மேற்பட்ட 
வரிசை அல்லது நெடுவரிசைகளைத் தேர்வு 
செய்க.

•	 9.9.1 மற்றும் 9.9.2ல் விவரிக்கப்பட்ட 
வழிமுறைகளைப் பின்பற்றவும்.

9.9.5 “Insert Cells” கருவிப்பட்டையைப் 
பயன்படுத்தி, வரிசை, நெடுவரிசை மற்றும் 
நுண்ணறைகளைச் சேர்த்தல்:

•	 நுண்ணறைகள், வரிசை மற்றும் 
நெடுவரிசைகளை சேர்க்க ”Insert Cells” 
மிதவை கருவிப்பட்டை பயன்படுகிறது.

•	 “Insert Cells” மிதவை கருவிப்பட்டையை 
பெற, View→Toolsbars → Insert Cells 
கட்டளையைக் கிளிக் செய்யவும்.
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•	 ஒரு சிறிய மிதவைக் கருவிப்பட்டை, நான்கு 
பணிக்குறிகளுடன் த�ோன்றும். இந்தப் 
பணிக்குறிகளைப் பயன்படுத்தி, ஒரு புதிய 
வரிசை, நெடுவரிசை மற்றும் நுண்ணறையை 
சேர்க்க முடியும். (படம் 9.37 காண்க)

வரிசை சேர்த்தல்

நெடுவரிசை 
சேர்த்தல்

வலது பக்கமாக நுண்ணறை சேர்த்தல்

கீழ் பக்கமாக நுண்ணறை சேர்த்தல்

படம் 9.37 Insert Cells மிதவைக் கருவிப்பட்டை
9.10 வரிசை மற்றும் நெடுவரிசைகளை 

நீக்குதல்:

	 ஒன்று அல்லது ஒன்றுக்கும் மேற்பட்ட 
வரிசை அல்லது நெடுவரிசைகளை நீக்க 
மு டி யு ம் .

அட்டவணைச் செயலியில், 
உண்மையில் ஒரு புதிய வரிசை 
அல்லது நெடுவரிசையை செருக 
முடியுமா?

	 அனைத்து அட்டவணை செயலிகளும், 
ஒரு குறிப்பிட்ட எண்ணிக்கையிலான 
வரிசைகளையும், நெடுவரிசைகளையும் 
க�ொண்டிருக்கும் எனில், புதிதாக ஒரு வரிசை 
மற்றும் நெடுவரிசையை எவ்வாறு செருக முடியும். 
அதற்கு ஏதேனும் சாத்தியக்கூறுகள் உள்ளதா?
உண்மையில் சாத்தியமில்லை.
ஒரு அட்டவணை செயலியில், புதிதாக ஒரு 
வரிசை அல்லது நெடுவரிசையை செருகுவது 
சாத்தியமற்றது. ஒரு புதிய வரிசை அல்லது 
நெடுவரிசை செருகப்படும் ப�ோது, ஏற்கனவே 
அந்த வரிசை அல்லது நெடுவரிசையிலுள்ள 
அனைத்து தரவுகள், வாய்ப்பாடுகள் மற்றும் 
வடிவூட்டல்கள் அடுத்த வரிசை அல்லது 
நெடுவரிசைக்கு மாற்றப்படுகின்றது. ஆனால், 
பார்வைக்கு ஒரு புதிய வரிசை அல்லது 
நெடுவரிசை செருகப்பட்டது ப�ோன்று  
த�ோன்றுகிறது. 

9.10.1 ஒன்றை வரிசை அல்லது நெடுவரிசையை 
நீக்குதல்:

•	 சுட்டியைப் பயன்பத்தி ஒற்றை வரிசை 
அல்லது நெடுவரிசையை நீக்கும் 
வழிமுறைகள்.

•	 நீக்கப்பட வேண்டிய வரிசை அல்லது 
நெடுவரிசையைத் தேர்ந்தெடுக்கவும்.

•	 Edit → Delete Cells கட்டளையைத் தேர்வு 
செய்க.

(அல்லது)
•	 நீக்கப்பட வேண்டிய வரிசை அல்லது 

நெடுவரிசை தலைப்பில் வலது கிளிக் 
ச ெ ய ்ய வு ம் .

•	 இப்போது த�ோன்றும், மேல்மீட்புப் 
பட்டியிலிருந்து, Delete Columns அல்லது 
Delete Rows கட்டளையைத் தேர்வு 
ச ெ ய ்ய வு ம் .

9.10.2 ஒன்றுக்கும் மேற்பட்ட வரிசை 
அல்லது நெடுவரிசைகளை நீக்குதல்:
•	 	ஒரே நேரத்தில் ஒன்றுக்கும் மேற்பட்ட வரிசை 

அல்லது நெடுவரிசைகளை நீக்க முடியும். 
(படம் 9.38யை காண்க)

•	 நீக்கப்பட வேண்டிய வரிசைகள் அல்லது 
நெடுவரிசைகளைத் தேர்வு செய்து 
க �ொள்ள    வு ம் .

•	தேர் வு செய்யபட்ட வரிசைகள் அல்லது 
நெடுவரிசைகளின் மீது வலது கிளிக் 
ச ெ ய ்ய வு ம் .

•	 இப்போது த�ோன்று மேல்மீட்புப் பட்டியிலுள்ள, 
Delete Column அல்லது Delete Rows 
கட்டளையை கிளிக் செய்யவும். அல்லது Edit 
→ Delete Cells தேர்வை கிளிக் செய்யவும்.

(1)	 எடுத்துக்காட்டு -1ல் உருவாக்கப்பட்ட 
அட்டவணைச் செயலியை 
தி றந்  து க �ொள்ள    வு ம் .

(2)	 ஏதேனும் மூன்று மாணவர்களின் 
தகவல்களை நீக்கி, க�ோப்பை சேமித்து 
மூ ட வு ம் .

செய்முறை பயிற்சி:

வரிசை அல்லது நெடுவரிசைகளை 
அழித்தல் சாத்தியமில்லை!!!

வரிசை அல்லது நெடுவரிசை 
செருகுதலில் கூறப்பட்டது 

ப�ோலவே, ஒரு வரிசை அல்லது நெடுவரிசையை 
நீக்குவதும் முற்றிலும் சாத்தியமில்லை. ஒரு 
வரிசை அல்லது நெடுவரிசை அழிக்கப்படும் 
ப�ோது, அதில் உள்ள அனைத்து தரவுகள், 
வாய்ப்பாடுகள் மற்றும் வடிவூட்டல்கள் 
அழிக்கப்படுகின்றது. ஆனால், பார்வைக்கு 
அந்த வரிசை அல்லது நெடுவரிசை  
அழிக்கப்பட்டது ப�ோல் த�ோன்றும்.

Chapter 9.indd   164 20-04-2020   15:59:24



165

தேர்ந்தெடுக்கப்பட்ட நெடுவரிசைகள்

தே  ர ்ந்தெ   டு க ்கப்ப   ட ்ட 
நெ  டு வ ரி சை  க ள ை 
இங்கே கிளிக் செய்யவும்

படம் 9.38 ஒன்றுக்கு மேற்பட்ட நெடுவரிசைகளை அழித்தல்
9.11 அட்டவணைத்தாள் வடிவூட்டல்:

	 நுண்ணறையிலுள்ள தரவுகளை வடிவூட்டல் செய்வது, அத்தரவுகளுக்கு கூடுதலான  தாக்கத்தை  
ஏற்படுத்துவதாகும். அத்தாக்கங்கள் படிப்பவரின் கவனத்தை ஈர்ப்பதற்காக செய்யப்படுகிறது. கூடுதல் 
தாக்கங்கள் என்பது, எழுத்துரு வகை, அளவு, நிறம் ப�ோன்றவற்றை மாற்றுதல், தானியங்கு மென் 
திருப்புதல், தடிமனாக்குதல், அடிக்கோடிடுதல், சாய்வெழுத்தாக்குதல் ப�ோன்றவையைக் குறிக்கும். 
கால்க்-ல் உள்ள தரவுகள் பல்வேறு வழிமுறைகளில் வடிவூட்டல் செய்யப்படுகிறது. 

9.11.1 உரை வடிவூட்டல்கள்:

	 நுண்ணறையில் உள்ளத் தரவுகளை தடிமனாக்குதல், சாய்வெழுத்தாக்குதல், அடிக�ோடிடுதல், 
எழுத்துருவின் வகை, அளவு, நிறம் மாற்றுதல் ப�ோன்றவை உரை வடிவூட்டல்களாகும். ஓபன் 
ஆஃபீஸ் ரைட்டரில் கற்றது ப�ோலவே, அனைத்து வடிவூட்டல் தேர்வுகளும் ”வடிவூட்டல் கருவிப் 
பட்டையில்” உள்ளது. (படம் 9.39 (அ) காண்க.)

நகர்வு புள்ளிகள்
தடிமனாக்குதல் சாய்வெழுத்தது

அடிக்கோடிடுதல்

நு ண்ணறை    
இணைப்பு

இடது, மைய, வலது மற்றும் 
நேர்த்தி இசைவுகள்

பாணிகள் எழுத்துரு வடிவங்கள் எழுத்துரு அளவு {

படம் 9.39 (அ) உரை வடிவூட்டல் பணிக்குறிகள்

வடிவூட்டல் தேர்வு விசைப்பலகை 

குறுக்குவழி

பயன்

எழுத்துரு வகை எழுத்துரு வகையை மாற்றப் பயன்படுகிறது.

எழுத்துரு அளவு எழுத்துருக்களின் அளவை மாற்றுவதற்கு பயன்படுகிறது.
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தடிமனாக்குதல் Ctrl + B தரவை தடிமனாக்குவதற்கு பயன்படுகிறது. 

சாய்வெழுத்தாக்குதல் Ctrl + I தரவை சாய்வெழுத்தாக மாற்றுவதற்கு பயன்படுகிறது.

அடிக்கோடிடுதல் Ctrl + U தரவுகளை அடிக்கோடிடுவதற்கு

வலது இசைவு Ctrl + L நுண்ணறைக்குள் தரவுகளை வலது இசைவில் அமைக்க.

இடது இசைவு Ctrl + R நுண்ணறைக்குள் தரவுகளை இடது இசைவில் அமைக்க.

மைய இசைவு Ctrl + E நுண்ணறைக்குள் தரவுகளை மைய இசைவில் அமைக்க.

நேர்த்தி இசைவு Ctrl + J
நுண்ணறைக்குள் தரவுகளை வலது மற்றும் இடது 

ஓரங்களில் சமமானதாக மாற்றுவதற்கு

நுண்ணறை சேர்ப்பு
தேர்ந்தெடுக்கப்பட்ட நுண்ணறைகளை, ஒரே 

நுண்ணறையாக மாற்றுவதற்கு. 

9.11.2 எண் வடிவூட்டல்:

	 நுண்ணறையிலுள்ள எண் தரவுகள் திரையில் த�ோன்றும் வடிவத்தை  மாற்றம் செய்ய எண் வடிவூட்டல் 
தேர்வுகள் பயன்படுகிறது. இந்த வடிவூட்டல் தேர்வுகள் உண்மை மதிப்பினை எந்த வகையிலும் மாற்றம் 
செய்யாது. எடுத்துக்காட்டக ஒரு எண்ணை, பண மதிப்பில் காட்டவேண்டுமெனில், (அதாவது அதன் 
உண்மை மதிப்பு மாறாமல், அதன் முன்னொட்டாக பணக்குறியீடு இணைக்கப்பட்டு, பின்னொட்டாக 
தசமப்புள்ளியுடன் காட்டவேண்டுமெனில்) படம் 9.39 (ஆ) காட்டப்பட்டுள்ள Number Format: 
Currency பணிக்குறி பயன்படுகிறது.

பணக்குறியீடு

சதவீதம் தசம புள்ளிகள் அழித்தல்

தசம புள்ளி சேர்த்தல்

இயல்புநிலை

படம் 9.39 (ஆ) எண் வடிவூட்டல் பணிக்குறிகள்

எண் வடிவூட்டல் விசைப்பலகை 

குறுக்குவழி
பணக்குறியீடு Ctrl+Shift+4
சதவீதம் Ctrl+Shift+5
இயல்புநிலை Ctrl+Shift+6

(1)	 எடுத்துக்காட்டு – 1ல் உருவாக்கப்பட்ட அட்டவணை செயலியை திறக்கவும்.

(2)	 அனைத்து தலைப்புகளையும் மைய இசைவுக்கு மாற்றி, அவற்றை தடிமனாக்குக.

(3)	 அனைத்து பதிவு எண்களையும், மதிப்பெண்களையும் மைய இசைவுக்கு மாற்றுக.

(4)	 அட்டவணையிள்ள தேர்வுகளுக்கு பலவகையாக எழுத்துரு வகைகளை  க�ொடுக்கவும்

(5)	சே மித்து மூடுக.

செய்முறை பயிற்சி
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 பயிற்சி பட்டறை: 1 

1.	 கீழ்க்காணும் தரவுகளுக்கு ஒரு அட்டவணைத் தாளை உருவாக்குக.

Emp. 
No

Name of Emp. Basic DA HRA CCA MA GPF IT HF

1001 Manivannan M 25500

Ba
sic

-ல்
 2

5%

Ba
sic

 ம
ற்

று
ம்

 D
A

-ல்
 1

5%

600 300

G
ro

ss
-ல்

 1
2%

G
ro

ss
-ல்

 %
10

250

1002 Kannan K 20200 600 300 250

1003 Gowrishankar N V 24300 600 300 250

1004 Lenin K 23400 600 300 250

1005 Suryanarayanan T 24100 600 300 250

1006 Ramesh K 18500 600 300 250

1007 Govindasami A 13200 600 300 250

1008 Kannan S 20250 600 300 250

1009 Penchil Rao K 28300 600 300 250

1010 Logeswaran M 30200 600 300 250

1011 Arumugam E 12000 600 300 250

1012 Vasu G N 25000 600 300 250

மேற்காணும் தரவுகளுக்கு……,  

(1)	 Gross Salary (ம�ொத்த சம்பளம்), Total Deductions (ம�ொத்த பிடித்தங்கள்) மற்றும் Net Salary 
(நிகர சம்பளம்) கணக்கிடுக. 

(2)	 “IT Cess” என்ற நெடுவரிசையைச் சேர்க்கவும், அதில், அனைத்து பணியாளர்களுக்கும் 3% cess 
கணக்கிடுக.

(3)	 “Govindasami” மற்றும் “Arumugam” ஆகிய�ோரின் பதிவுகளை நீக்குக. 

(4)	 கீழ்க்காணும் பணியளார்களின் விவரங்களைச் சேர்க்கவும்.

(5)	 GPF, IT,மற்றும் Cess ஆகியவற்றின் ம�ொத்த த�ொகையைக் கணக்கிடுக.

Emp.
No

Name of Emp. Basic DA HRA CCA MA GPF IT HF

2001 Murali G 24750
2002 Munirathnam A 23550
2003 Ramakrishnan V G 25500
2004 Srinivasan R 27500
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பயிற்சி பட்டறை: 2 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை திறந்துக�ொள்க. 

2.	 “Chennai whole sale Marketing Pvt. Ltd.”-ன் 2018-ஜனவரி மாதத்தின் சரக்கிருப்பு 	

	 மற்றும் விற்பனை விவரங்களை உள்ளிடுக.
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100 Marie Gold 120 345 15 147 5%
101 Milk Bikis 85 106 10 63 5%
102 Dark Fantasy 75 147 25 43 3%
103 Nutri Choice 250 98 50 12 10%
104 Lays potato chips 52 172 15 152 4%
105 Oreo 120 112 25 85 6%

3.	 வாய்பாடு பயன்படுத்தி, பின்வருவனவற்றை கணக்கிடுக. 

	 (i) Amount of Discount, Selling price மற்றும் Amount of sales ஒவ்வொரு ப�ொருளுக்கும். 

	 (ii) இந்த மாதத்தின் ம�ொத்த தள்ளுபடி (Total amount of discount) மற்றும் விற்பனை.

	 (iii) ஒவ்வொரு ப�ொருளுக்குமான இறுதி சரக்கிருப்பு. 

பயிற்சி பட்டறை: 3 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை உருவாக்குக.

2.	 Tamil Finance Corporation” நிறுவனத்தின், ஜனவரி 2018க்கான அனுமதிக்கப்பட்ட கடன் 	

	 விவரங்களை உள்ளிடவும். 

3. 	 கீழுள்ளவைகளை கணக்கிடுவதற்கான வாய்பாடு உருவாக்குக.

(i)	 Interest, Total amount மற்றும் due date.

(ii)	 இந்த மாதத்தில் அனுமதிக்கப்பட்ட ம�ொத்த கடன், பெற்ற வட்டி மற்றும் ம�ொத்த த�ொகை 

	 (கடன் + வட்டி).
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2001 Senthil 250000 02/01/2018 120 days 9.5%

2002 Kumar 175000 15/01/2018 150 days 9.5%

2003 Ibrahim 550000 16/01/2018 140 days 10.5%

2004 Valli 375000 21/01/2018 210 days 10%

2005 Charles 450000 28/01/2018 130 days 10.5%

4.	 Kumar மற்றும் Ibrahim ஆகிய இருவரின் பதிவுகளுக்கு இடையே ஐந்து புதிய வரிசைகளை 	

	ச ெருகி, கீழ்காணும் நபர்களின் விவரங்களை உள்ளிடுக.
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3001 Pari 250000 03/02/2018 125 days 9.5% 5%
3002 Arul 375000 07/02/2018 155 days 9.5% 5%
3003 Raman 350000 10/02/2018 130 days 10.5% 3%
3004 Givind 450000 10/02/2018 100 days 10% 10%
3005 Zeenath 800000 26/02/2018 90 days 10% 4%

நினைவில் க�ொள்வோம்

•	 அட்டவணை செயலி அலுவலக பயன்பாட்டிற்குத் தேவையான தரவுகளை ஒருங்கிணைத்து, 

ஆராய்ந்து, சேமித்து அட்டவணை வடிவில் தருவதற்கு பயன்படும் மிகச் சிறந்த கருவியாகும்.

•	 டேனியல் பிரிக்லின் மற்றும் பாப் ஃப்ராங்ஸ்டன் ஆகிய�ோர், 1979- ஆம் ஆண்டு, ஆப்பிள் II 

என்ற கணிப்பொறிக்காக உருவாக்கப்பட்ட, விசிகால்க் (Visicalc) முதல் அட்டவணைச்செயலி.

•	 ஓபன் ஆஃபீஸ் கால்க் ஒரு பிரபலமான திறந்த மூல (Open Source) அட்டவணைச்செயலி 

ஆகும். இதனை தற்போது அபாச்சி (Apache) நிறுவனம் நிர்வகித்து வருகிறது.
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நினைவில் க�ொள்வோம்

•	 அட்டவணைத்தாள் என்பது கட்டங்களுடன் கூடிய நுண்ணறைகளைக் க�ொண்ட ஒரு 
அமைப்பு ஆகும். அதன் ஒவ்வொறு நுண்ணறையிலும் நிரலாக்கப்பட்ட கணிப்பான்கள் 
இணைந்துள்ளது.

•	 ஓபன் ஆஃபீஸ் கால்க் பதிப்பு 4.1.5 ம�ொத்தம் 1024 நெடுவரிசைகளையும், 10,48,576 
வரிசைகளையும் க�ொண்டுள்ளது.

•	 ஒரு வரிசையும், நெடுவரிசையும் இணையுமிடத்தில் உருவாகும் பெட்டி ப�ோன்றத�ொரு அமைப்பு 
“நுண்ணறை” அல்லது “கலம்” என்று அழைக்கப்படுகிறது.

•	 அட்டவணைத்தாள் முழுவதும் நகர்த்தக் கூடிய, செவ்வக வடிவிலான பெட்டி ப�ோன்ற அமைப்பு 
“நுண்ணறைச் சுட்டி” என்று அழைக்கப்படுகிறது.

•	 எந்த நுண்ணறையில் நுண்ணறை சுட்டி தற்போது உள்ளத�ோ, அந்த நுண்ணறை ”செயற்படு 
கலம்” (Active Cell) எனப்படும். 

•	 அனைத்து வாய்பாடுகளும் = குறியுடன் த�ொடங்க வேண்டும்

•	 நான்கு வகையான இயக்கிகள் கால்கில் உள்ளது.

செயல்பாடு

மாணவர் செயல்பாடு

1. 	 வாய்ப்பாடுகளைப் பயன்படுத்தி கணக்கீடுகள் செய்யப்படும் கருதுரு அடிப்படையில் பல்வேறு 

அட்டவணை தாள் தரவுகளை உருவாக்கும் பயிற்சிகள்.

ஆசிரியர்செயல்பாடு

1. 	 அட்டவணை செயலியில் வேலை செய்தலை எளிய எடுத்துக்காட்டுகளுடன் விளக்க வேண்டும்.
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மதிப்பீடு

பகுதி - அ 

சரியான விடையை தேர்ந்தெடு:

1.	 முதல் அட்டவணை செயலி எது?

	 (அ) எக்ஸெல் (Excel)			   (ஆ) ல�ோட்டஸ் 1-2-3 (Lotus 1-2-3)
	 (இ) விசி கால்க் (Visicalc)		  (ஈ) ஓபன் ஆஃபீஸ் கால்க் (OpenOffice Calc)

2.	 ஓபன் ஆஃபீஸ் கால்க்-ன்  மூலப்பயன்பாடு எது? 

	 (அ) விசி கால்க் (Visicalc)		  (ஆ) லிப்ரே கால்க் (LibreCalc)
	 (இ) ல�ோட்டஸ் 1-2-3 (Lotus 123)		 (ஈ) ஸ்டார் ஆஃபீஸ் கால்க் (StarOffice Calc)

3.	 கட்டங்களுடன் கூடிய நிரலாக்கப்பட்ட கணிப்பான்: 

	 (அ) அட்டவணைச் செயலி			   (ஆ) தரவுத்தளம்

	 (இ) ச�ொற்செயலி					     (ஈ) லினக்ஸ்

4.	 கால்க்-ல் ஒரு நெடுவரிசையின் தலைப்பு என்பது:

	 (அ) எண் 		 (ஆ) குறியீடு	  	 (இ) தேதி		  (ஈ) எழுத்து

5.	 அட்டவணைத்தாளிற்குள் நுண்ணறை சுட்டியை முன்னோக்கி நகர்த்தும் ப�ொத்தான் எது? 

	 (அ) Enter	 (ஆ) Tab	 	 (இ) Shift + Tab		 (ஈ) Delete

6.	 ஒரு வாய்பாடு இவற்றுள் எதில் த�ொடங்கலாம் 

	 (அ) =		  (ஆ) +			   (இ) -			   (ஈ) இவையனைத்தும்

7.	 + A1^B2 என்ற வாய்பாட்டுகான வெளியீட்டு மதிப்பு எது? (A1=5, B2=2 எனில்)

	 (அ) 7		  (ஆ) 25			   (இ) 10			   (ஈ) 52

8.	 = H1<>H2 என்ற கூற்றுக்கான வெளியீட்டு மதிப்பு என்ன? (H1=12, H2=12 எனில்)
	 (அ) True		 (ஆ) False		  (இ) 24			   (ஈ) 1212

9.	த னித்த நுண்ணறைப் பார்வையிடலுக்கு பயன்படுத்தப்படும் குறியீடு எது? 

	 (அ) +		  (ஆ) %			   (இ) &			   (ஈ) $

10.	 இவற்றுள் எந்த சவிசேர்மானத்தை பயன்படுத்தி நடப்பு நெடுவரிசையின் அகலத்தை அதிகரிக்கலாம் ?

	 (அ) Alt+Right arrow		  (ஆ) Ctrl+Right arrow			   (இ) Alt+Left arrow		
(ஈ) Ctrl+Left arrow

பகுதி - ஆ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்:

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் எத்தனை வகையான கருவிப்பட்டைகள் உள்ளது? 

2.	 நுண்ணறைச் சுட்டி என்றால் என்ன?  

3.	 ஓபன் ஆஃபீஸ் கால்க்-ன் உரை செயற்குறியை பற்றி குறிப்பு வரைக.

4.	 கால்க்-ல் ஒரு வாய்ப்பட்டை உருவாக்குவதற்கான ப�ொது கட்டளை அமைப்பை எழுதுக. 

5.	ந கலெடுத்தல், வெட்டுதல் மற்றும் ஒட்டுவதற்கான குறுக்குவழி சாவி சேர்மானங்கள் யாவை?

6.	 ஒரு நுண்ணறையிலுள்ள தரவுகளை பதிப்பாய்வு செய்ய முடியுமா? ஆம் எனில் எவ்வாறு? 
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7.	 “Insert Cells” உரையாடல் பெட்டியிலுள்ள தேர்வுகள் யாவை?

8.	ப�ொ ருத்துக.

அ ஆ

(அ) வெட்டுதல், நகலெடுத்தல் மற்றும் ஒட்டுதல் (1) தனித்த நுண்ணறை
(ஆ) நுண்ணறை சுட்டி (2) நிலைமைப் பட்டை
(இ)  தேர்ந்தெடுப்பு நிலை (3) செந்தரக் கருவிப்பட்டை

(ஈ) $A$5 (4) இயங்கு கலம்

9.	 வரையறுக்க (1) உரை செயற்குறி (2) அட்டவணை செயலியில் வரிசை மற்றும் நெடுவரிசை

10.	  நகலெடுத்து ஒட்டுதல் மற்றும் வெட்டி ஒட்டுதல் வேறுபடுத்துக.

பகுதி - இ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 ஓபன் ஆஃபீஸ் கால்க் – குறிப்பு வரைக. 

2.	 கால்க்-ல் நெடுவரிசை மற்றும் நுண்ணறைகளை சேர்த்தல் பற்றி எழுதுக.

3.	 Backspace மற்றும் Delete ப�ொத்தான்களைப் பயன்படுத்தி தரவுகளை அழித்தலை வேறுபடுத்துக. 

4.	 ஏதேனும் மூன்று வடிவூட்டல் தேர்வுகளை எழுதுக. 

5.	 நுண்ணறை A1, A2 மற்றும் A3 யில் முறையே, 34, 65 மற்றும் 89 ஆகிய மதிப்புகள் உள்ளது. அதன் 
சராசரியை காணும் வாய்பாட்டை எழுதுக. 

பகுதி - ஈ

அனைத்து வினாக்களுக்கு விடையளிக்கவும்: 

1.	 கால்க்-ல் நெடுவரிசையின் அகலத்தை எவ்வாறு மாற்றலாம் என்பதை விளக்குக. 

2.	 5, 10, 20 ….. 2560 என்ற எண் வரிசையை உருவாக்கும் வழிமுறையை விளக்குக.

3.	 பின்வரும் அட்டவணையை உற்று ந�ோக்கவும். 

A B C D E
1 Year Chennai Madurai Tiruchi Coimbatore
2 2012 1500 1250 1000 500
3 2013 1600 1000 950 350
4 2014 1900 1320 750 300
5 2015 1850 1415 820 200
6 2016 1950 1240 920 250

	 2012 முதல் 2016ம் ஆண்டுகளில், தமிழகத்தின் முக்கிய நகரங்களில் விற்பனை செய்யப்பட்ட 
குளிரூட்டியின் விவரங்கள் க�ொடுக்கப்பட்டுள்ளது. இந்த தரவுகளின் அடிப்படையில், பின்வருவனவற்றுக்கு 
வாய்பாடுகளை எழுதுக.

(1)	 2015ம் ஆண்டின் ம�ொத்த விற்பனை 

(2)	 2012 முதல் 2016 வரை க�ோயம்புத்தூரின் ம�ொத்த விற்பனை. 

(3)	 2015 மற்றும் 2016ம் ஆண்டுகளில், மதுரை மற்றும் திருச்சியின் ம�ொத்த விற்பனை

(4)	 2012 முதல் 2016 வரை சென்னையின் சராசரி விற்பனை.

பயிற்சி பட்டறை: 2 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை திறந்துக�ொள்க. 

2.	 “Chennai whole sale Marketing Pvt. Ltd.”-ன் 2018-ஜனவரி மாதத்தின் சரக்கிருப்பு 	

	 மற்றும் விற்பனை விவரங்களை உள்ளிடுக.
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100 Marie Gold 120 345 15 147 5%
101 Milk Bikis 85 106 10 63 5%
102 Dark Fantasy 75 147 25 43 3%
103 Nutri Choice 250 98 50 12 10%
104 Lays potato chips 52 172 15 152 4%
105 Oreo 120 112 25 85 6%

3.	 வாய்பாடு பயன்படுத்தி, பின்வருவனவற்றை கணக்கிடுக. 

	 (i) Amount of Discount, Selling price மற்றும் Amount of sales ஒவ்வொரு ப�ொருளுக்கும். 

	 (ii) இந்த மாதத்தின் ம�ொத்த தள்ளுபடி (Total amount of discount) மற்றும் விற்பனை.

	 (iii) ஒவ்வொரு ப�ொருளுக்குமான இறுதி சரக்கிருப்பு. 

பயிற்சி பட்டறை: 3 

1.	 ஓபன் ஆஃபீஸ் கால்க்-ல் ஒரு புதிய அட்டவணைத்தாளை உருவாக்குக.

2.	 Tamil Finance Corporation” நிறுவனத்தின், ஜனவரி 2018க்கான அனுமதிக்கப்பட்ட கடன் 	

	 விவரங்களை உள்ளிடவும். 

3. 	 கீழுள்ளவைகளை கணக்கிடுவதற்கான வாய்பாடு உருவாக்குக.

(i)	 Interest, Total amount மற்றும் due date.

(ii)	 இந்த மாதத்தில் அனுமதிக்கப்பட்ட ம�ொத்த கடன், பெற்ற வட்டி மற்றும் ம�ொத்த த�ொகை 

	 (கடன் + வட்டி).
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அட்டவணைச் செயலி 
Spreadsheet

கணிப்பொறியில், கணக்கீடுகளை செய்யப் பயன்படும் ஒரு 
மென்பொருள்.   

என்ன - எனில் பகுப்பாய்வு 
What-if analysis

ஒரு குறிப்பிட்ட நுண்ணறையில் உள்ள மதிப்புகளில் செய்யப்படும் 
மாற்றங்கள் அதன் வெளியீட்டை எவ்வாறு பாதிக்கும் என்பதை 
அறிவதாகும்.

விசி கால்க்
VisiCalc

முதல் மின் அட்டவணை செயலி.

GUI வரைகலைப் பயனர் இடைமுகம்.

எக்ஸெல்
Excel

மைக்ரோசாஃட் நிறுவனத்தால் உருவாக்கப்பட்ட மிகப் பிரபலமான 
அட்டவணைச் செயலி.

நுண்ணறை
Cell

வரிசை மற்றும் நெடுவரிசை குறிக்கிடுவதால் ஏற்படும் அமைப்பு.

நுண்ணறை முகவரி
Cell Pointer

அட்டவணைச் செயலியில், ஒரு நுண்ணறையை சுற்றி பளிச்சென்று 
தெரியும் ஒரு செவ்வக அமைப்பு.

செயற்படு கலம்
Active cell

தற்போது நுண்ணறைச் சுட்டி உள்ள நுண்ணறை.

வாய்பாடு
Formula

க�ொடுக்கப்பட்ட ஒரு மதிப்பின் மீது, என்ன மாதிரியான கணித 
செயல்பாடு செய்யப்பட வேண்டும் என்பதை குறிக்கும் ஒரு கணிதச் 
சமன்பாட்டுக் க�ோவை. 

செயற்குறி
Operator

கணக்கீடுகள்,  கணிப்பீடுகள் மற்றும் செயல்பாடுகளை செய்யப் 
பயன்படும் குறியீடு. 

பரப்பு
Range

ஒரு குறிப்பிட்ட எண்ணிக்கையில் அமைந்த நுண்ணறைகளின் 
த�ொகுப்பு.

BODMAS விதி கணித கணக்கீட்டின் செயல்பாட்டு வரிசை:
Brackets (அடைப்புக் குறிகள்) - Orders (அடுக்குகள் மற்றும் 
வர்க்க மூலம்) -  Division (வகுத்தல்) - Multiplication (பெருக்கல்) 
- Addition (கூட்டல்) - Subtraction (கழித்தல்).

இழுத்து நிரப்புதல் புள்ளி
Drag fill handle

நுண்ணறைச் சுட்டியின் கீழ் வலது மூலையில் அமைந்துள்ள ஒரு 
சிறிய சதுரப் பெட்டி ப�ோன்றத�ொரு அமைப்பு.

செயற்கூறுகள்
Function

முன்னரே வரையறுக்கப்பட்ட வாய்பாடுகள் (அல்லது) ஒற்றை 
மதிப்பைய�ோ அல்லது ஒன்றுக்கும் மேற்பட்ட மதிப்புகளைய�ோ 
விடையாக தரும் சிறிய கட்டளைத் த�ொகுப்பு.

வரைபடம்
Chart

தரவுகளை வரைபடங்களாக குறிப்பிடுவது.
Graphical representation of data.

தரவுத்தளம்
Database

பெரிய அளவிலான, தரவுகளின் முறைபடுத்தப்பட்ட த�ொகுப்பு.

ஒற்றைக் க�ோப்புத் 
தரவுத்தளம்
Flat file database

ஒற்றைத் தரவு அட்டவணையைக் க�ொண்ட தரவுதள வகை. 

ச�ொற்களஞ்சியம்
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